
CleanSweep 95 Contents

Introducing CleanSweep
Welcome to CleanSweep

Quick Start (for experienced users)
Uninstalling Instructions
Archiving Instructions

Getting Started
Overview
The Main Window at a Glance
Getting Help
Exit CleanSweep
Where To Find Common CleanSweep Tasks

Uninstalling
Overview
Running the Uninstall Wizard
Finding and Selecting a Folder or Program
Taking Safety Precautions
Reviewing your Selection
Uninstalling
Viewing a Summary
Uninstalling on a Network

Archiving
Overview
Running the Archive Wizard
Finding and Selecting a Folder or Program
Selecting an Archive Destination
Reviewing your Selection
Archiving
Viewing a Summary

Backing Up and Transporting
Overview



Running the Backup or Transport Wizard
Finding and Selecting a Folder or Program
Selecting a Destination
Reviewing your Selection
Packaging
Viewing a Summary

Moving
Overview
Running the Move Wizard
Finding and Selecting a Folder or Program
Selecting a Destination
Reviewing your Selection
Moving
Viewing a Summary

Finding Unneeded Files
Overview
Selecting a Finder
Finding Duplicate Files
Finding Redundant DLL Files
Finding Unused Files by Type
Finding Infrequently Used Files
Finding Orphaned Files
Cleaning Up Unneeded Files
A Note on Viewers

Restoring
Overview
Running the Restore Wizard
Selecting a Backup
Selecting Files
Taking Safety Precautions
Selecting a Restore Location
Restoring
Viewing a Summary

Reports



Overview
Viewing the Master Log
Viewing the Savings Report
Viewing the Folder/Directory Usage Report

Customizing CleanSweep
Overview
Configuring the Usage Monitor (Windows 3.1x and 95 only)
Configuring the Install Monitor (Windows 3.1x and 95 only)
Changing Backup and Restore Options
Changing the Default Report File



Welcome to CleanSweep
Welcome to CleanSweep 95, the premier Windows cleanup program!

Note:    CleanSweep runs on Windows 95, Windows 3.1, Windows for Workgroups 3.11, and 
Windows NT 3.51 servers or workstations.    This help file describes the use of CleanSweep in 
Windows 95 and notes any differences that apply to the other platforms.

To get the most out of Windows, you need to manage your hard disk space.    Today's programs 
are larger than ever and it is likely that at some point you will run out of disk space and find it 
necessary to delete unnecessary or infrequently used programs and files.

Windows programs have long had a tendency to scatter their contents across multiple directories,
making it difficult to purge your computer of all the program's components.    Windows 95 itself 
takes up even more space.    Your PC probably contains many redundant, obsolete, and unused 
files and programs you no longer use.    Now is the time to clean up your hard disk.    

CleanSweep is more than just an uninstall program.    It is a multipurpose utility for minimizing 
hard disk clutter and reclaiming disk space.    CleanSweep can remove unneeded DOS programs 
and Windows 16- and 32-bit programs and system components.    You can also use it to delete 
unneeded duplicate files.    If you have recently upgraded to Windows 95, CleanSweep safely 
cleans up all remnants of Windows 3.1. The resulting increase in available disk space will greatly 
improve your computer's performance and free up disk space so you can install new programs.

Related Topics:
Obtaining Late-Breaking Information



Obtaining Late-Breaking Information
CleanSweep's READ ME file contains any late-breaking information that did not make it into this 
Help file.    

To view the READ ME file in Windows 95: 

1 Click the Windows Start button, and then point to Programs.

The Programs menu appears.

2 Point to the Quarterdeck CleanSweep 95 folder.

3 Click READ ME.

WordPad opens and displays the READ ME file. 

To view the READ ME file in Windows 3.1, 3.11, and NT: 

· Double-click the README icon in the CleanSweep program group.

NotePad opens and displays the READ ME file.



Uninstalling Instructions
This topic gives a quick explanation of how to uninstall a complete program from your hard drive.  
New users should read Running the Uninstall Wizard before using this quick start.    

To uninstall a program:

1 Start CleanSweep.

In Windows 95, click the Quarterdeck CleanSweep 95 icon on the desktop, or click 
the Start button, point to Programs, and then click the Quarterdeck CleanSweep 
95 icon.    

In Windows 3.1, 3.11, and NT, open the Quarterdeck CleanSweep program group by 
double-clicking its program group icon.    Start CleanSweep by double-clicking the 
Quarterdeck CleanSweep 95 icon.

CleanSweep appears.

Windows 95 users:    You can drag and drop a program onto a CleanSweep shortcut icon to start
CleanSweep, then skip ahead to step 4. 

2 Start the Uninstall Wizard.

Click the Uninstall Wizard (Alt+U) icon in the Program tab.

The Uninstall Wizard dialog box appears.    The Wizard will guide you through the 
uninstall process.

3 Select the Program to Uninstall.    

Double-click a folder or program group to open it.    Click the program you want to 
uninstall.    If you cannot find the program in a folder, click the Find (Alt+F) button.    
Click Next (Alt+F) when you have selected the program to uninstall.    If you 
monitored the installation of the program you want to uninstall, use the icon located in
the "Programs Monitored by Install Monitor" folder/program group. 

4 Select Safety Precautions.  

Click Next (Alt+N) to create a backup.    Click Next (Alt+N) again if the folder shown 
is where you want your backup copy of the program to go.    To select another folder 
or directory, click in the text box and type another path, or click the ... button (the 
Browse button) and select a destination.    

Click View if you want to take a closer look at what will be uninstalled.    

Click Next (Alt+N) to accept the confirmation settings and proceed with the 
uninstallation. 

5 Start Uninstalling.    

Click Finish (Alt+F) .    The Wizard uninstalls the program and asks if you would like 
to view a summary.    Click Summary if you would like to view the summary, print the 



summary, or save the summary to a file.    

6 Uninstall Complete!

Click OK.



Archiving Instructions
If you are unsure about uninstalling a program because you think there is a chance you might 
need it in the future, you can archive it.    The Archive Wizard creates a backup of a program in a 
compressed format for future retrieval and creates an archive icon for the program.    The original 
files and configuration information are deleted from your computer.    When you need the 
program, simply click its archive icon and CleanSweep restores it.

This topic explains how to archive a complete program from your hard drive.    New users should 
read Running the Archive Wizard before using this quick start.

To archive a program:

1 Start CleanSweep.

In Windows 95, click Quarterdeck CleanSweep 95 icon on the desktop, or click the 
Start button, point to Programs, and then click the Quarterdeck CleanSweep 95 
icon.    

In Windows 3.1, 3.11, and NT, open the Quarterdeck CleanSweep program group 
by double-clicking its program group icon.    Start CleanSweep by double-clicking the 
Quarterdeck CleanSweep 95 icon.

CleanSweep appears.

2 Start the Archive Wizard.

Click the Archive Wizard (Alt+A) icon in the Program tab.    The Archive Wizard 
dialog box appears.    The Wizard will guide you through the archive process.

3 Select the Program to Archive.  

Double-click a folder or program group to open it.    Click the program you want to 
archive.    If you cannot find the program in a folder, click the Find (Alt+F) button.    
Click Next (Alt+N) when you have selected the program to archive.    If you monitored
the installation of the program you want to archive, use the icon located in the 
"Programs Monitored by Install Monitor" folder/program group.

4 Select an Archive Destination.    

Click Next (Alt+N) again if the folder or directory shown is where you want to store 
the backup copy of the program. To select another folder or directory, click in the text 
box and type another path, or click the ... button (the Browse button) and select a 
destination.          

5 Start Archiving.  

Click Finish (Alt+F) .    The Wizard archives the program and asks if you would like to
view a summary.    Click Summary if you would like to view a summary, print the 
summary, or save the summary to a file.      

6 Archive Complete!

Click OK. CleanSweep archives the program and adds the words "CleanSweep 



Archive" to the original icon description to indicate that the program is archived.    To 
restore the program, simply click the icon.



Overview
In the following Help topics you will learn:

· How CleanSweep's main window is organized.    

· What the CleanSweep monitors do.

· How to use this online Help system.

Related Topics:
The CleanSweep Monitors (Windows 3.1x and 95 only)



The CleanSweep Monitors (Windows 3.1x and 95 only)

Note:    CleanSweep's Install Monitor, Usage Monitor and file viewers were not available for NT 
users at publication time.    Please check the READ ME file for more information.

When you elect to use the Install Monitor and Usage Monitor, Windows 95 will automatically 
display two symbols on the taskbar.    In Windows 3.1x, two tasks will be added to the task list and
two minimized icons will appear on the desktop.

These symbols (or tasks) represent CleanSweep's Usage Monitor and Install Monitor.    These 
monitors run in the background to keep track of edits to existing configuration files, installation 
information about any new programs you add to your computer, and how often you use files.    All 
this happens behind the scenes and normally you do not have to be concerned with the monitors. 

More Info:    For more information about the monitors, including how to prevent them from loading
at Windows startup, see Configuring the Usage Monitor (Windows 3.1x and 95 only) and 
Configuring the Install Monitor (Windows 3.1x and 95 only).    Also see Tracking a Program 
Installation for information on how the Install Monitor works.



The Main Window at a Glance
The first window you see when you start CleanSweep is the main window.    You can use this 
window to access any CleanSweep program function.    

The main window contains five tabs:    Program, Cleanup, Restore, View and Options.    When you
click one of these tabs, CleanSweep displays a new list of options.

Related Topics:
The Program tab
The Cleanup tab
The Restore tab
The View tab
The Options tab



The Program tab
The Program tab on the CleanSweep main window contains five Wizards¾helper programs that 
guide you step-by-step though a particular process: 

Uninstall Wizard¾deletes programs.    Uninstall deletes not only the program's individual 
components (files), but also any external references to the file, such as program icons or entries 
in system configuration files (such as the Registry or SYSTEM.INI).    The Wizard is smart enough
to leave program components that are used by other programs intact.

Archive Wizard¾uninstalls programs but saves copies of the program's files and configuration 
information in a compressed format that takes up much less disk space than the original files.    
This gives you the best of both worlds, because you can free needed space on your hard disk 
and still retrieve the program whenever you want.    The Archive Wizard creates a an archive icon 
you can click if you can click if you ever want to restore the program.

Backup Wizard¾creates a single, compressed backup file of a program for use as a reserve in 
the event that you ever need to restore the program. Backing up leaves all of the original files and
configuration information in place.

Move Wizard¾moves a program to another drive or folder/directory.

Transport Wizard¾transports a program file to a disk or other storage medium.    Use this Wizard
to transport data to your laptop, home computer, or other computers.

To start any Wizard, simply click its icon.    In general, the Wizards will guide you through the 
process by asking you a question.    When you have answered the question, click Next (Alt+N) .    
When you are done, click Finish (Alt+F) .



The Cleanup tab
The Cleanup tab on the CleanSweep main window contains "Finders" that locate specific types of
files:    the Duplicate File Finder, the Redundant DLL Finder, the Unused File Type Finder, the Low
File Usage Finder, and the Orphan Finder.    

After you locate unneeded files with a Finder, you can delete, archive, back them up, move, or 
transport them.

For information on using the Cleanup tab options, see Finding Unneeded Files.



The Restore tab
The Restore tab on the CleanSweep main window contains the Restore Wizard, which restores to
their original states the files you have backed up, archived, or transported.

For information on restoring files, see Restoring.    



The View tab
The View tab on the CleanSweep main window contains options for three reports that summarize 
your CleanSweep activities.    

Master Log report¾keeps track of all of the actions performed, so you can always look up any 
file or activity.    It will also tell you where a backup was stored and how many bytes of disk space 
were freed. 

Savings report¾details the amount of space freed, the amount of spaced used by backups and 
the total overall savings. All totals are in kilobytes (KB).    

Folder Usage report¾details folder/directory information.

For information on these reports, see Reports.



The Options tab
The Options tab on the CleanSweep main window contains the Configure CleanSweep icon, 
which you can use to customize CleanSweep to suit your personal preferences.

For more information, see Customizing CleanSweep.



Getting Help
CleanSweep's online Help system provides a quick and easy way to get answers to your 
questions.

To access Help:

· Click the Help (Alt+H) button, or press F1.

CleanSweep's Help window opens.

The Help window contains the following tabs:

· The Contents tab opens a window that lists the major topics available in the Help system.

· The Index tab opens the search window, used to look up topics using keywords or by 
scrolling through a list of topics.

· The Find tab opens a search window that you can use to search for specific words and 
phrases in Help topics, instead of searching by category.

Related Topics:
Jump to another topic



Jump to another topic
On many Help screens, you will see words and phrases that appear in green with a solid 
underline.    These are jump terms that provide cross-references to other topics.    When you point 
to one, the cursor takes the shape of a pointing finger.    If you click a jump term, a Help window 
on that topic appears.    After you read the jump term's Help window, you can return to the original 
Help window by pressing the Back button.

You will also see words and phrases with dotted underlines.    These terms provide more 
information about the word or phrase underlined.    Click the word or phrase to display more 
information.    



Exit CleanSweep
To exit CleanSweep:

· Click the Exit (Alt+X) button.



Where To Find Common CleanSweep Tasks
Now that you are familiar with CleanSweep's main window, what you read next depends on what 
you want to do.

To Learn More About See the Topic

Uninstalling a program Running the Uninstall Wizard
Archiving a program Running the Archive Wizard
Backing Up or Transporting a program to
another computer

Running the Backup or Transport Wizard

Moving a program to another drive or 
directory

Running the Move Wizard

Restoring a program to its original state Running the Restore Wizard
Finding specific type of files so you can 
delete, move, back up or transport them.

Selecting a Finder

CleanSweep Reports Viewing the Master Log and Viewing the 
Savings Report

Customizing CleanSweep Configuring the Usage Monitor (Windows
3.1x and 95 only), Configuring the Install 
Monitor (Windows 3.1x and 95 only), and
Changing Backup and Restore Options.

Overview
In the following Help topics you will learn:

· How to delete a program and its related components to save space on your computer's hard 
disk, even if the program is used on a network. 

· How to view a summary report of what was uninstalled.

Removing programs you no longer need is the fastest way to reclaim a lot of disk space. 
CleanSweep can remove a single program or all of the programs in a folder or program group. 
CleanSweep removes program files and all of the components associated with them. The more 
software you remove, the more disk space you will free and the better your computer will run. 

The basic steps to uninstalling a program are:

1 Run the Uninstall Wizard

2 Select the program or folder/group to uninstall

3 Take optional safety precautions. You can back up the program and have the Wizard verify 
each file deletion before it happens.

4 Review your selection

5 Uninstall the program or folder/group

The following Help topics describe these steps in detail.





Running the Uninstall Wizard
To run the Uninstall Wizard:

· Click the Uninstall Wizard icon (Alt+U) in the CleanSweep Program tab.

In Windows 95, the Uninstall Wizard displays a program tree that contains the 
following expandable folders: 

· a folder containing the programs on the Windows 95 Start menu 

· a Desktop folder that contains any desktop shortcut icons

· a folder containing any programs that have been monitored by CleanSweep's 
Install Monitor. (If you have not yet monitored any program installations, the 
folder is empty and the folder's description is "No programs monitored by Install 
Monitor.") 

You can expand these folders and select their subfolders or a program folder. The 
plus and minus buttons expand and collapse the branches of the folder tree.

In Windows 3.1, 3.11, and Windows NT, the Uninstall Wizard displays the Windows 
program groups in alphabetical order. In Windows 3.1x, it also includes a program 
group that contains a list of programs previously monitored by the Install Monitor. (If 
you have not yet monitored any program installations, the program group is titled "No 
programs monitored by Install Monitor.")

The Wizard will guide you through the uninstallation process. 

To find other folders or programs on your hard drive:

· Click the Find button (Alt+F), and then skip ahead to Finding Files.



Finding and Selecting a Folder or Program
The methods you can use to find and select a program are:

· Select a program from a folder or group.

· Select all of the programs contained in a folder or group.

· Browse or search for a program and then select it.

Related Topics:
Opening and Closing a Folder/Group
Selecting From a Folder or Program Group
Selecting a Folder or Program Group
Where is That File?
Finding Files



Opening and Closing a Folder/Group
In Windows 95, the folders in the Uninstall Wizard's main window are expandable/collapsible. The
plus sign to the left of a folder indicates that it contains subfolders. The subfolders contain 
program items or other subfolders. When you expand a subfolder you can collapse it; that is, 
close it so only the "parent" folder appears.

To display a folder's contents in Windows 95:

· Click the plus sign.

The folder expands and its subfolders appear. The plus sign changes to a minus sign.

To close a folder in Windows 95:

· Click the minus sign.

The folders disappear. The minus sign changes to a plus sign.

In Window 3.1, 3.11, and NT, the program groups in the main window are expandable/collapsible. 
The program groups contain program items.

To display the items in a Windows 3.1x or NT program group:

· Double-click the program group.

The program items appear. 

To close a Windows 3.1x or NT program group:

· Double-click the program group.

The program items disappear.

Note:    If you cannot locate a file in a folder or program group, see Where is That File?



Selecting From a Folder or Program Group
Use this method to select a program in a folder or group from the Uninstall Wizard's main window.

To select a program from a folder:

1 Double-click the folder or group that contains the program.

2 Select the program by clicking it.

3 Click the Next button (Alt+N) .

CleanSweep analyzes your hard drive to determine whether the program uses any other 
components. CleanSweep then asks if you want to back up the file(s). See Taking Safety 
Precautions.

During its analysis, CleanSweep may determine that you have selected a file or a group of files 
that you should not uninstall. If so, a dialog box will warn you not to uninstall the program and 
explain the reason why. You should follow the Wizard's recommendations unless you are 
absolutely sure that the file can be safely uninstalled.

After the warning, CleanSweep continues with the uninstall process. The files that CleanSweep 
believes should not be uninstalled are color coded in yellow or red. Later, CleanSweep will 
display a list of files to be uninstalled, and will give you a chance to remove from the list any files 
marked in yellow (see Reviewing your Selection), CleanSweep will not remove any files marked 
in red. When you add a file or component to the list (see Examining the List in More Detail), 
CleanSweep displays its safety level as blue, indicating that CleanSweep has not given its own 
safety level to the file.



Selecting a Folder or Program Group
Use this method to select the entire contents of a folder or program group from the Uninstall 
Wizard's main window.

To select the entire folder or program group:

1 Click the folder or group.

The folder or group is selected.

2 Click the Next button (Alt+N) .

CleanSweep analyzes your hard drive to determine whether the program uses any other 
components. CleanSweep then asks if you want to back up the file(s). See Taking Safety 
Precautions.

During its analysis, CleanSweep may determine that you have selected a file or a group of files 
that you should not uninstall. If so, a dialog box will warn you not to uninstall the program and 
explain the reason why. You should follow the Wizard's recommendations unless you are 
absolutely sure that the file can be safely uninstalled.

After the warning, CleanSweep continues with the uninstall process. The files that CleanSweep 
believes should not be uninstalled are color coded in yellow or red. Later, CleanSweep will 
display a list of files to be uninstalled, and will give you a chance to remove from the list any files 
marked in yellow (see Reviewing your Selection), CleanSweep will not remove any files marked 
in red. When you add a file or component to the list (see Examining the List in More Detail), 
CleanSweep displays its safety level as blue, indicating that CleanSweep has not given its own 
safety level to the file.



Where is That File?
If you cannot find a program in a folder or program group, it might be that it is a DOS program or 
an "orphaned file."    In Windows 95, an orphaned file is a Windows program that is not on the 
Start menu or one of its submenus. An orphaned file could also be a Windows program that is not
associated with or attached to a Windows shell.

Although CleanSweep does not display DOS programs in its tree, you can still search for and 
delete them. To select a DOS program or an orphaned file, click the Find button (Alt+F) on the 
Wizard's main window, and then use the Browse button or Search button. Browse lets you locate 
programs by navigating through your folders/program groups and making selections with the 
mouse or by selecting files by name or by wildcard. Search scans your local hard drives for all 
program files.    See Finding Files.

The Cleanup tab provides the best ways to find specific types of files¾ for example, duplicate or 
temporary files. See Finding Unneeded Files for more information on finding specific file types.



Finding Files
The methods described in this Help topic locate individual files, rather than entire programs or 
program folders/groups. These methods can help if you wish to find a program but cannot 
remember where it is stored or it you want to find orphaned or DOS programs using the Uninstall 
Wizard.

You may also use the Cleanup tab to search for specific file types, such as duplicate, unused, or 
orphaned files. For more information, see Finding Unneeded Files.

Related Topics:
Browsing For a Program
Searching for a Program



Browsing For a Program
Use this method to select any single file from a folder/group or directory. 

To browse for a program:

1 Click the Find button (Alt+F) on the Uninstall Wizard's main window.

2 Click the Browse button (Alt+B) .

The Browse for a Program dialog box appears. The default folder is that of the 
selected program or folder/group.    The main window in this dialog displays a 
scrollable list of files and folders, arranged alphabetically by name¾folders or 
directories first, and then the files.

Windows 95 users:  The following procedures describe how to browse for a program in Windows
95.

1 To move up a level in the "folder tree," press the Up One Level button on the toolbar. 

To look in a folder above the current one, or to look on another drive, click the Look 
in list box (Alt+I). To look in a folder or subdirectory, double-click the folder in the 
main window below the Look in box. 

To see more details about the files and folders in the main window, click the Details 
button on the toolbar. 

2 Select a file or type a filename in the File name entry field. 

In Windows 95, a filename can be more than eight characters, and may contain 
periods, commas, hyphens, exclamation points, and spaces. If you do not know the 
entire filename, you can use the asterisk (*) or question mark (?) as wildcard 
characters. The dialog box only displays program files by default. To display all file 
types, click the Files of type list box, and then select All Files (*.*).

3 Click the Open button (Alt+O).

The Wizard does a quick analysis of the file, then asks if you want to back it up. (See 
Taking Safety Precautions).

WIN 3.1x and NT:    The following procedures describe how to browse for a file in Windows 3.1, 
Windows for Workgroups 3.11, and Windows NT.

To change drives:

· Click the drop-down button in the Drives drop-down list box (Alt+V), and then make 
another selection.

To change directories:

· Double-click the directory name in the Directories list box (Alt+D).

To select a file:



1 Click the filename.

2 Click the OK button.

The Wizard does a quick analysis of the file, then asks if you want to back it up. (See 
Taking Safety Precautions.)



Searching for a Program
Use this method to locate a single file from a list of specific program types, including all programs,
DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Click the Find button (Alt+F) on the Uninstall Wizard's main window.

2 Click the Search button (Alt+S) .

The Search for a Program dialog box appears. 

3 The Wizard searches all local hard drives by default. To specify another drive to 
search, click the Drives To Search: box (Alt+D), select one or more drives from the 
dialog box, then click OK.

4 The Wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click the drop-down button in the Files of Type list box (Alt+T) 
then choose Windows Programs, DOS Programs, or Dynamic Link Libraries.

5 Use the scroll bar to move up and down the file list, and then click the filename to 
select it. You may only select one program at a time.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and the file's size in bytes.      

6 After you have selected a file, click OK.

The Wizard does a quick analysis of the file, then asks if you want to back it up.



Taking Safety Precautions
After you have selected an item to uninstall, CleanSweep provides two optional safety 
precautions: backup and confirmation of each file deletion.

Related Topics:
Backing Up the Files
Confirming File Deletion



Backing Up the Files
After you have selected an item to uninstall and before CleanSweep deletes anything, it asks if 
you want to create a compressed backup copy. The default is yes. We recommend that you make
a backup unless you are sure that you want to permanently delete the selected items from your 
computer.

To back up the items you uninstall:

1 Click the Next button (Alt+N) .

A dialog box shows the name of the default backup folder.    In Windows 95 and NT, 
the backup folder is: 

C:\PROGRAM FILES\CLEANSWEEP\BACKUP 

In Windows 3.1 and 3.11, the default backup directory is 
C:\CLNSWEEP\BACKUP

You can choose a different backup folder or directory by editing the displayed name 
or by clicking the ... button (the Browse button) and browsing for a different backup 
folder or directory. 

Note:    When you select a new backup folder or directory, CleanSweep uses it one time only and 
does not save the change for the next uninstallation. To change the default backup folder or 
directory permanently, use the Options tab, as described in Changing the Default Backup Folder.

2 Click the Next button (Alt+N) to store the backup in the currently selected folder or 
directory.



Confirming File Deletion
After you have selected an item to uninstall, CleanSweep asks whether you want to confirm the 
deletion of each file. During confirmation, you can view a text, graphic, or document file before it 
is deleted to verify that you want to delete it. 

To uninstall without confirming each file:

· Click the Next button (Alt+N) . 

Note: You can turn the confirmation option off. See Customizing CleanSweep.

To confirm each deletion:

1 Click the Yes button (Alt+Y) .

2 Click the Next button (Alt+N) .



Reviewing your Selection
After you have selected an item to uninstall and selected safety precautions, CleanSweep 
displays a summary of what it is about to do. The summary notes which file or files will be 
uninstalled and the number of bytes of disk space that will be freed.

Press the View button on this screen to display a description and the safety level of each file that 
CleanSweep believes is associated with your choice. You may be able to view some files to be 
sure you want to uninstall them. 

If you are sure you want to uninstall all the files listed, see Uninstalling.

Related Topics:
Examining the List in More Detail



Examining the List in More Detail
After you have selected an item to uninstall and selected safety precautions, CleanSweep 
displays a summary of what it is about to do.

To examine the list closely:

· Click the View button (Alt+V) .

The Select the Components to Uninstall dialog box displays the title of the folder or 
program group (if any), and the filenames and related components to be uninstalled. 
The files and components are grouped by their "parent" program. By default, 
CleanSweep will present for deletion all files with a green safety level¾all files that 
CleanSweep is sure can be uninstalled safely. Files with a yellow safety level are also
candidates for uninstalling, but CleanSweep will not uninstall them unless you 
specifically select them. When you add a file or component to the list (see below), 
CleanSweep displays its safety level as blue, indicating that CleanSweep has not 
given its own safety level to the file. 

The Wizard uses Windows file viewers to let you take a quick peek at a file without 
having to launch the application that created it. After you have verified the file's 
contents, you can better decide whether you wish to uninstall it. This adds another 
layer of safety to the uninstalling process.

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active. You can
use the Run button to launch the program if you want to see what it does. 

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active. You can use the Link 
button if you want to display a description of any DLL files the program uses, or any 
programs that depend upon that file. 

2 Click the View or Run button (Alt+V) or (Alt+R) .

The file appears (or the program launches if you clicked Run). 

Windows 95 users:    If the file does not display properly, you may have to install the Windows 95
Quick View file viewers from the Windows 95 CD-ROM. For installation instructions, see your 
Windows 95 documentation, or see A Note on Viewers.

To see a file description without launching the file:

 · Select the filename in the list. 

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to uninstall, you should clear their check boxes.



To prevent a file from being deleted:

· Clear the file's check box by clicking on it.

You may want to uninstall files that do not appear on the list.

To add a file to the list:

1 Click the Add button (Alt+A) . 

The Add Component dialog box appears.

2 Type a filename in the file entry area, then click OK.

You may specify a filename, or you may choose to remove sections from the WIN.INI 
file. The WIN.INI file contains sections that are often shared between programs from 
the same vendor, so only select a section if you are absolutely sure it is not used by 
another program.

You can also change or print the list so you can cancel the uninstallation and verify each file on 
your own, or, you might keep the printout as a record of what you uninstalled.

To print the list:

1 Click the Print List button (Alt+P) . 

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list and then click OK. 



Uninstalling
After you have selected an item to uninstall, selected safety precautions, and reviewed the 
summary information, you are ready to uninstall.

To uninstall the program:

1 Click the Finish button (Alt+F) .

That's all there is to it.    CleanSweep uninstalls the program. 

If you made a backup copy of the program, you can restore it using the Restore Wizard. See 
Running the Restore Wizard.

If you want to see more details on what CleanSweep did, you can view a summary, 
as described in Viewing a Summary.

2 When you have finished viewing the summary, click the OK button.



Viewing a Summary
When the uninstallation is complete, a dialog box reports the action as completed, and asks if you
want to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears. The text window contains a detailed description of the 
actions performed, including the following:

Date and time that the uninstallation was performed

Object that was uninstalled

Backup destination, if any

Title of the folder or directory, if applicable

Title of the program and the complete pathname for each program in the folder or 
group 

Description of the program 

Number of bytes deleted.

Note:  The number of bytes deleted might be slightly larger than the approximate estimate (listed 
just before you click the Finish button) due to "slack space." Each file is stored in clusters of a 
certain size, depending on the hard disk's partition size. The last cluster of a file takes a full 
cluster, whether it uses all of the space or not. For example, if your hard disk partition contained 
4096-byte clusters, uninstalling a 4097-byte file would free 8192 bytes of disk space.

To print the report:

· Click the Print button (Alt+P).

The report is printed.

To save the report in a file:

1 Click the Save button (Alt+S) .

The Save Summary dialog box appears.

2 Type a filename for the report, then click Save (Alt+S). (Click OK if you are using 
Windows 3.1, 3.11, or Windows NT.)

In Windows 95 and NT, CleanSweep uses 
C:\PROGRAM FILES\CLEANSWEEP\SAVEREP.TXT 

as the default report filename. 



In Windows 3.1 and 3.11, CleanSweep uses 

C:\CLNSWEEP\SAVEREP.TXT 

as the default report filename.

To change the report filename permanently, use the Options tab as described in 
Changing the Default Report File.

To close the report:

· Click the Close button (Alt+C) .

The report closes.

MORE INFO:  The summary report describes one activity at a time.    For a report on all 
CleanSweep activity, you can view the Master Log report, as described in Viewing the Master 
Log.



Uninstalling on a Network
Suppose you are a network administrator and you want to uninstall a program on a network drive 
because the program is no longer used at your company. CleanSweep can uninstall a program 
from the network drive and remove the program's files and components from all workstations on 
the network.

To remove a program's components from workstations, you tell CleanSweep to create a Network 
Decoy. The Network Decoy is a copy of CleanSweep that acts as a substitute for a network 
program that has been uninstalled. When a user tries to run the program from a workstation on 
the network, they will instead run the Network Decoy, which uninstalls all components of the 
program from their workstation's hard disk.    

IMPORTANT:  Do not delete a program from a network drive unless you are authorized to do so.

When you create a network decoy, you can enter a custom message that the user will see when 
he or she tries to run the program.    For example, you could enter a message like this:

This program is no longer used at this site.    It has been removed from the network drive, 
and its related files will now be removed from your computer to free more disk space.    
Please continue with the uninstall process.

By displaying a message, you let users know what is happening and make them feel more 
comfortable with the uninstall process.

NOTE:  The network decoy feature will not run if a copy of CleanSweep is already running.

To uninstall a program from a network drive:

1 Click the Uninstall Wizard icon on the Program tab (Alt+U) .

2 Use the Browse or Search method to select the program you want to uninstall from 
the network drive.    See Browsing For a Program or Searching for a Program.

The Select the Components to Uninstall dialog box appears.

3 Make sure that each component you want to uninstall is marked with a check. To 
select a component, select its check box.    To deselect a component, clear the check 
box.

4 Click the Select this line to create a Network Decoy check box.

5 Click OK.

A dialog box asks you to enter a custom message.

6 Type message to the network users, informing them that the program has been 
deleted. It is a good idea to enter a message that will make it clear that the program 
has been deleted from the network drive and will be deleted from their hard drive to 
free valuable hard drive space.

7 When you are done typing the message, click OK.



A dialog box asks you to specify a Network Decoy type.    The type you select 
depends on whether CleanSweep is installed on the network drive in a location 
accessible by users over the network.

If CleanSweep is accessible by all the users who run the program you are 
uninstalling, select Single Copy.    When the user attempts to access the program, a 
Network Decoy file will be installed on their computer.    This file, along with the 
network copy of CleanSweep, will be sufficient to uninstall the program's files on the 
workstations.

If CleanSweep is not accessible to all the users who run the program, select Multiple 
Copy.    When the user attempts to access the program, those CleanSweep files 
which are necessary to uninstall the program will be installed on their computer.    

8 Select Single Copy or Multiple Copy, whichever is appropriate, then select OK and 
continue uninstalling.

Once the program has been deleted from the network drive, a copy of CleanSweep 
will be installed in its place on the network drive.    Any user who attempts to run the 
program will instead run a copy of CleanSweep that will uninstall all traces of the 
original program from his or her hard drive.



Overview
In the following Help topics you will learn how to:

· Archive a program and its related components to save space on your computer's hard disk.

· View a summary report of what was archived.    

You can free hard disk space easily and safely by archiving programs that you need only 
occasionally. CleanSweep can remove a single program or all of the programs in a folder or 
program group. Program files and all of the components associated with them are stored in a    
compressed format for future retrieval. The compressed archive takes only a fraction of the disk 
space of the original program. Later, you can easily restore the archived program with a click of 
the mouse.

The basic steps to archiving a program are:

1. Run the Archive Wizard

2. Select the program or folder/group to archive

3. Select a destination folder/directory

4. Review your selection

5. Archive the program or folder/group.

The following Help topics describe these steps in detail.



Running the Archive Wizard
To run the Archive Wizard:

· Click the Archive Wizard icon (Alt+A) in the CleanSweep Program tab.

In Windows 95, the Archive Wizard displays a program tree that contains the 
following expandable folders:

· a folder containing the programs on the Windows 95 Start menu 

· a Desktop folder that contains any desktop shortcut icons

· a folder containing any programs that have been monitored by CleanSweep's 
Install Monitor. (If you have not yet monitored any program installations, the 
folder is empty and the folder's description is "No programs monitored by Install 
Monitor.") 

You can expand these folders and select their subfolders or a program folder. The 
plus and minus buttons expand and collapse the branches of the folder tree.

In Windows 3.1, 3.11, and NT, the Archive Wizard displays the Windows program 
groups in alphabetical order.    

In Windows 3.1x, the program tree also includes a program group that contains a list 
of programs previously monitored by the Install Monitor. (If you have not yet 
monitored any program installations, the program group is titled "No programs 
monitored by the Install Monitor.") 

The Wizard will guide you through the archiving process.

To find other folders or programs on your hard drive:

· Click the Find button (Alt+F) , and then skip ahead to Finding Files.



Finding and Selecting a Folder or Program
The methods you can use to find and select a program are:

· Select a program from a folder or group.

· Select all of the programs contained in a folder or group.

· Browse or search for a program and then select it.

Related Topics:
Opening and Closing a Folder/Group
Selecting From a Folder or Program Group
Selecting a Folder or Program Group
Finding Files



Opening and Closing a Folder/Group
In Windows 95, the folders in the Archive Wizard's main window are expandable/collapsible. The 
plus sign to the left of a folder indicates that it contains subfolders. The subfolders contain 
program items or other subfolders. When you expand a subfolder you can collapse it; that is, 
close it so only the "parent" folder appears.

To display a folder's contents in Windows 95:

· Click the plus sign.

The folder expands and its subfolders appear. The plus sign changes to a minus sign.

To close a folder in Windows 95:

· Click the minus sign.

The subfolders disappear. The minus sign changes to a plus sign.

In Windows 3.1, 3.11, and NT, the program groups in the main window are 
expandable/collapsible.    The program groups contain program items.    

To view a program group's subdirectories, double-click the program group and its 
subdirectories appear. The subdirectories contain program items. 

To close the program group, double-click it again.

Note:    If you cannot locate a file in a folder or program group, see Where is That File?



Selecting From a Folder or Program Group
Use this method to select a program in a folder or group from the Archive Wizard's main window.

To select a program from a folder:

1 Double-click the folder/group that contains the program.

2 Select the program by clicking it.

3 Click the Next button (Alt+N), or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any other 
components. CleanSweep then asks for an archive destination. See Selecting an Archive 
Destination.

During its analysis, CleanSweep may determine that you have selected a file or a group of files 
that you should not archive. If so, a dialog box will warn you not to uninstall the program and 
explain the reason why. You should follow the Wizard's recommendations unless you are 
absolutely sure that the file can be safely archived.

After the warning, CleanSweep continues with the archive process. The files that CleanSweep 
believes should not be archived are color coded in yellow or red. Later, CleanSweep will display a
list of files to be archived, and will give you a chance to remove from the list any files marked in 
yellow (see Reviewing your Selection), CleanSweep will not remove any files marked in red. 
When you add a file or component to the list (see Examining the list in more detail), CleanSweep 
displays its safety level as blue, indicating that CleanSweep has not given its own safety level to 
the file.



Selecting a Folder or Program Group
Use this method to select the entire contents of a folder or program group from the Archive 
Wizard's main window.

To select the entire folder or program group:

· Click the folder or group.

The folder or group is selected.

3 Click the Next button (Alt+N), or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any other 
components. CleanSweep then asks for an archive destination. See Selecting an Archive 
Destination.

During its analysis, CleanSweep may determine that you have selected a file or a group of files 
that you should not archive. If so, a dialog box will warn you not to archive the program and 
explain the reason why. You should follow the Wizard's recommendations unless you are 
absolutely sure that the file can be safely archived.

After the warning, CleanSweep continues with the archive process. The files that CleanSweep 
believes should not be archived are color coded in yellow or red. Later, CleanSweep will display a
list of files to be archived, and will give you a chance to remove from the list any files marked in 
yellow (see Reviewing your Selection), CleanSweep will not remove any files marked in red. 
When you add a file or component to the list (see Examining the list in more detail), CleanSweep 
displays its safety level as blue, indicating that CleanSweep has not given its own safety level to 
the file.



Finding Files
The methods described in this Help topic locate individual files, rather than entire programs or 
program folders/groups. These methods can help if you wish to find a program but cannot 
remember where it is stored or if you want to find orphaned or DOS programs using the Archive 
Wizard.

You may also use the Cleanup tab to search for specific file types, such as duplicate, unused, or 
orphaned files. For more information, see Finding Unneeded Files.

Related Topics:
Browsing For a Program
Searching for a Program



Browsing For a Program
Use this method to select any single file from a folder/group or directory. 

To browse for a program:

1 Click the Find Button (Alt+F) on the Archive Wizard's main window.

2 Click the Browse button (Alt+B) .

The Browse for a Program dialog box appears. The main window in this dialog 
displays a scrollable list of files and folders, arranged alphabetically by name¾folders
or directories first, and then the files.

Windows 95 users:  The following procedure describes how to browse for a program in Windows
95.

1 To move up a level in the "folder tree," press the Up One Level button on the toolbar. 

To look in a folder above the current one, or to look on another drive, click the Look 
in list box (Alt+I). To look in a folder or subdirectory, double-click the folder in the 
main window below the Look in box. 

To see more details about the files and folders in the main window, click the Details 
button on the toolbar. 

2 Select a file or type a filename in the File name entry field. 

In Windows 95, a filename can be more than eight characters, and may contain 
periods, commas, hyphens, exclamation points, and spaces. If you do not know the 
entire filename, you can use the asterisk (*) or question mark (?) as wildcard 
characters. The dialog box only displays program files by default. To display all file 
types, click the Files of type list box, and then select All Files (*.*).

3 Click the Open button (Alt+O) .

The Wizard does a quick analysis of the file, then asks for archive destination.    See 
Selecting an Archive Destination.

Windows 3.1, 3.11, and NT users:    The following procedures describe how to browse for and 
select a file in Windows 3.1, 3.11, and Windows NT.

To change drives:

· Click the drop-down button in the Drives drop-down list box (Alt+V), and then make 
another selection.

To change directories:

· Double-click the directory name in the Directories list box (Alt+D).

To select a file:



1 Click the filename.

2 Click the OK button.

The Wizard does a quick analysis of the file, then asks for an archive destination. 
See Selecting an Archive Destination.



Searching for a Program
Use this method to locate a single file from a list of specific program types, including all programs,
DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Click the Find button (Alt+F) on the Archive Wizard's main window.

2 Click the Search button (Alt+S) .

The Search for a Program dialog box appears. 

3 The Wizard searches all local hard drives by default. To specify another drive to 
search, click the Drives To Search: box, select one or more drives from the dialog 
box, then click OK.

4 The Wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click the drop-down button in the Files of Type list box then 
choose Windows Programs, DOS Programs, or Dynamic Link Libraries.

5 Use the scroll bar to move up and down the file list, and then click the filename to 
select it. You may only select one program at a time.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and the file's size in bytes. 

6 After you have selected a file, click OK.

The Wizard does a quick analysis of the file, then prompts you for a destination folder
for the archive. See Selecting an Archive Destination.



Selecting an Archive Destination
After you have selected an item to archive, the Wizard asks where you want to store the archive.

To select an archive folder/directory:

1 Click the Next button (Alt+N) .

A dialog box shows the name of the default backup folder/directory.    

In Windows 95 and NT, the default folder is: 

C:\PROGRAM FILES\CLEANSWEEP\BACKUP

In Windows 3.1 and 3.11, the default backup directory is 

C:\CLNSWEEP\BACKUP

You can choose a different backup folder or directory by editing the displayed name 
or by clicking the ... button (the Browse button) and browsing for a different backup 
folder or directory. 

Note: When you select a new backup folder or directory, CleanSweep uses it one time only and 
does not save the change for the next archive. To change the default backup folder or directory 
permanently, use the Options tab, as described in Changing the Default Backup Folder. 

2 Click the Next button (Alt+N) to store the archive in the currently selected destination.



Reviewing your Selection
After you have selected an item to archive and an archive destination, the Archive Wizard 
displays a summary of what it is about to do. The summary notes which file or files will be 
archived and the number of bytes of disk space that will be freed.

The View button on this screen displays a description and the safety level of each file that 
CleanSweep believes is associated with your choice. You may be able to view some files to be 
sure you want to archive them. You can also change or print the list of displayed files before you 
continue. 

If you are sure you want to archive all the files listed, continue with Archiving.

Related Topics:
Examining the list in more detail



Examining the list in more detail

After you have selected an item to archive and selected an archive destination, the Wizard 
displays a summary of what it is about to do.

To examine the list closely:

· Click the View button (Alt+V) .

The Select the Components to Archive dialog box displays the title of the folder or 
program group (if any), and the filenames and related components to be archived. 
The files and components are grouped by their "parent" program. By default, 
CleanSweep will preselect for deletion all files with a green safety level¾all files that 
CleanSweep is sure can be archived safely. Files with a yellow safety level are also 
candidates for archiving, but CleanSweep will not archive them unless you 
specificially select them. When you add a file or component to the list (see below), 
CleanSweep displays its safety level as blue, indicating that CleanSweep has not 
given its own safety level to the file.

The Wizard uses Windows file viewers to let you take a quick peek at a file without having to 
launch the application that created it. After you have verified the file's contents, you can better 
decide whether you wish to archive it. This adds another layer of safety to the archiving process.

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active. You can
use the Run button to launch the program if you want to see what it does.

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active. You can use the Link 
button to display a description of any DLL the file uses, or any programs that depend 
upon that file.

2 Click the View (Alt+V) or Run (Alt+R) button.

The file appears (or the program launches if you clicked Run).

Windows 95 users:    If the file does not display properly, you may have to install the Windows 95
Quick View file viewers from the Windows 95 CD-ROM.    For installation instructions, see your 
Windows 95 documentation or see A Note on Viewers.

To see a file description without launching the file:

· Select the filename in the list.

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to archive, you should clear their check boxes.

To prevent a file from being archived:



· Clear the file's check box by clicking it.

You may want to archive files that do not appear on the list.

To add a file to the list:

1 Click the Add (Alt+A) button. 

The Add Component dialog box appears.

2  Type a filename in the file entry area, then click OK.

You may specify a filename, or you may choose to remove sections from the WIN.INI 
file. The WIN.INI file contains sections that are often shared between programs from 
the same vendor, so only select a section if you are absolutely sure it is not used by 
another program.

You might want to print the list so you can cancel the archive and verify each file on your own, or, 
you might keep the printout as a record of what you archived.

To print the list:

1 Click the Print List (Alt+P) button.

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list and then click OK. 



Archiving
After you have selected an item to archive, selected an archive destination, and reviewed the 
summary information, you are ready to archive.

To archive the program:

1 Click the Finish (Alt+F) button.

That's all there is to it. CleanSweep creates an archive of the program, and adds 
"CleanSweep archive" to the program's icon in the folder or program group.

To restore the program in Windows 95, just double-click its archive shortcut.    

Note:    If CleanSweep is running, close it before clicking the archive shortcut.

To restore the program in Windows 3.1, 3.11, or Windows NT, just double-click its 
archive icon.

If you want to see more details on what CleanSweep did, you can view a summary, 
as described in Viewing a Summary.

2 When you have finished viewing the summary, click the OK button.



Viewing a Summary
When the archive is complete, a dialog box reports the action as completed, and asks if you want 
to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears. The text window contains a detailed description of the 
actions performed, including the following:

·    Date and time that the archive was performed

·    Object that was archived

·    Archive destination

·    Title of the folder or directory, if applicable

·    Title of the program and the complete pathname for each program in the folder or
group 

·    Description of the program 

·    Number of bytes archived.    

Note:    The number of bytes archived might be slightly larger than the approximate estimate 
(listed just before you click the Finish button) due to "slack space."    Each file is stored in clusters 
of a certain size, depending on the hard disk's partition size.    The last cluster of a file takes a full 
cluster, whether it uses the all of the space or not.    For example, if your hard disk partition 
contained 4096-byte clusters, archiving a 4097-byte file would free 8192 bytes of disk space.

To print the report:

· Click the Print (Alt+P) button.

The report is printed.

To save the report in a file:

1 Click the Save (Alt+S) button.

The Save Summary dialog box appears.

2 Type a filename for the report, then click Close (Alt+C).

Windows 95 and NT use 
C:\PROGRAM FILES\CLEANSWEEP\SAVEREP.TXT 
as the default report filename. 

Windows 3.1 and 3.11 use C:\CLNSWEEP\SAVEREP.TXT



as the default report filename.

To change the report filename permanently, use the Options tab as described in 
Changing the Default Report File.

To close the report:

· Click the Close button (Alt+C).

The report closes.

MORE INFO:  The summary report describes only the activity that has just been performed. For a
report on all of CleanSweep's activity, take a look at the Master Log report, as described in 
Viewing the Master Log.



Overview
In this topic you will learn how to:

· "Package" a program and all of its associated components into one file. Once you create the 
file, you can use it as a backup copy or transport it to another computer, such as your laptop.

· View a summary report of what was packaged.

The packaged program file takes only a fraction of the disk space of the original program. The 
original program remains intact. To restore the packaged program, simply run the Restore Wizard,
which is much easier than reinstalling and reconfiguring. 

Related Topics:
Which Wizard Should I Use?



Which Wizard Should I Use?
If you want to Use

Make a backup copy of a program for 
insurance against loss of data.

The Backup Wizard

Save a copy of an older program 
version.

The Backup Wizard

Transport a program from your desktop 
computer to another computer, such as 
your laptop.

The Transport Wizard

The basic steps to packaging a program are:

1. Run the Backup or Transport Wizard

2. Select the program or folder/group to package

3. Select a destination

4. Review your selection

5. Package the program or folder/group

The following Help topics describe these steps in detail.



Running the Backup or Transport Wizard
To run the Backup or Transport Wizard:

· Click the Backup (Alt+B)or Transport Wizard (Alt+T) icon in the CleanSweep 
Program tab. 

In Windows 95, the Wizard displays a program tree that contains the following 
expandable folders:

· a folder containing the programs on the Windows 95 Start menu 

· a Desktop folder that contains any desktop shortcut icons

· a folder containing any programs that have been monitored by CleanSweep's 
Install Monitor. (If you have not yet monitored any program installations, the 
folder is empty and the folder's description is "No programs monitored by Install 
Monitor.") 

You can expand these folders and select their subfolders or a program folder. The 
plus and minus buttons expand and collapse the branches of the folder tree.

In Windows 3.1, 3.11, and NT, the Wizard displays the Windows program groups in 
alphabetical order.    

In Windows 3.1x, the program tree also includes a program group that contains a list 
of programs previously monitored by the Install Monitor. (If you have not yet 
monitored any program installations, the program group is titled "No programs 
monitored by the Install Monitor.") 

The Wizard will guide you through the packaging process. 

To find other folders or programs on your hard drive:

 · Click the Find button, and then skip ahead to Finding Files.



Finding and Selecting a Folder or Program
The methods you can use to find and select a program are:

· Select a program from a folder or group.

· Select all of the programs contained in a folder or group.

· Browse or search for a program and then select it.

In Windows 95, the folders in the Wizard's main window are expandable/collapsible. The plus 
sign to the left of a folder indicates that it contains subfolders. The subfolders contain program 
items or other subfolders. When you expand a subfolder you can collapse it; that is, close it so 
only the "parent" folder appears.

To display a folder's contents in Windows 95:

· Click the plus sign.

The folder expands and its subfolders appear. The plus sign changes to a minus sign.

To close a folder in Windows 95:

· Click the minus sign.

The subfolders disappear. The minus sign changes to a plus sign.

In Windows 3.1, 3.11, and NT, the program groups in the main window are 
expandable/collapsible.    The program groups contain program items.    

To view a program group's subdirectories, double-click the program group and its 
subdirectories appear. The subdirectories contain program items. 

To close the program group, double-click it again.

Note:    If you cannot locate a file in a folder or program group, see Where is That File?

Related Topics:
Selecting From a Folder or Program Group
Selecting a Folder or Program Group
Finding Files



Selecting From a Folder or Program Group
Use this method to select a program in a folder or group from the Wizard's main window.

To select a program from a folder:

1 Double-click the folder/group that contains the program.

2 Select the program by clicking it.

3 Click the Next button (Alt+N), or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components. CleanSweep then asks for a destination; see Selecting a 
Destination.



Selecting a Folder or Program Group
Use this method to select the entire contents of a folder or program group from the Wizard's main 
window.

To select the entire folder or program group:

· Click the folder or group.

The folder or group is selected.

3 Click the Next button (Alt+N), or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components. CleanSweep then asks for a destination; see Selecting a 
Destination.



Finding Files
The methods described in this section locate individual files, rather than entire programs or 
program folders/groups. These methods can help if you wish to find a program, but cannot 
remember where it is stored or if you want to find orphaned or DOS programs using the Backup 
or Transport Wizards.

You may also use the Cleanup tab to search for specific file types, such as duplicate, unused, or 
orphaned files. For more information, see Finding Unneeded Files.

Related Topics:
Browsing For a Program
Searching for a Program



Browsing For a Program
Use this method to select any single file from a folder/group or directory.

To browse for a program:

1 Click the Find button (Alt+F).

2 Click the Browse button (Alt+B).

The Browse for a Program dialog box appears. The main window in this dialog 
displays a scrollable list of files and folders, arranged alphabetically by name¾folders
or directories first, and then the files.

Windows 95 users:    The following procedures describe how to browse for a program in 
Windows 95.

1 To move up a level in the "folder tree," click the Up One Level button on the toolbar. 

To look in a folder/group above the current one, or to look on another drive, click the 
Look in list box (Alt+I). To look in a folder within the current folder, double click the 
folder in the main window below the Look in box.

To see more details about the files and folders in the main window, click the Details 
button on the toolbar.

2 Select a file or type a filename in the File name entry field. 

In Windows 95, a filename can be more than eight characters, and may contain 
periods, commas, hyphens, exclamation points, and spaces. If you do not know the 
entire filename, you can use the asterisk (*) or question mark (?) as wildcard 
characters. The dialog box displays only program files by default. To display all file 
types, click the Files of type list box, and then select All Files (*.*).

3 Click the Open button (Alt+O).

The Wizard does a quick analysis of the file, then asks for a destination. See 
Selecting a Destination.

Windows 3.1, 3.11, and NT users:    The following procedures describe how to browse for and 
select a program in Windows 3.1, 3.11 and NT.

To change drives:

 · Click the drop-down button in the Drives drop-down list box (Alt+V), and then make 
another selection.

To change directories:

 · Double-click the directory name in the Directories list box (Alt+D).

To select a file:



1 Click the filename.

2 Click the OK button.

The Wizard does a quick analysis of the file, then asks for a destination. See 
Selecting a Destination.



Searching for a Program
Use this method to locate a single file from a list of specific program types, including all programs,
DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Click the Find button (Alt+F) on the Wizard's main window.

2 Click the Search button (Alt+S) .

The Search for a Program dialog box appears. 

3 The Wizard searches all local hard drives by default. To specify another drive to 
search, click the Drives To Search: box (Alt+D), select one or more drives from the 
dialog box, then click OK.

4 The Wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click the drop-down button in the Files of Type list box (Alt+T) 
then choose Windows Programs, DOS Programs, or Dynamic Link Libraries.

5 Use the scroll bar to move up and down the file list, and then click the filename to 
select it. You may only select one program at a time.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and the file's size in bytes.      

6 After you have selected a file, click OK.

The Wizard does a quick analysis of the file, then asks for a destination.    See 
Selecting a Destination.



Selecting a Destination
After you have selected an item to package, CleanSweep asks where you want to store the 
package.

To select a destination:

1 Click the Next button (Alt+N).

A dialog box shows the name of the default destination.

In Windows 95 and NT, the default folder in the Backup Wizard is

C:\PROGRAM FILES\CLEANSWEEP\BACKUP

In Windows 3.1 and 3.11, the default directory in the Backup Wizard is

C:\CLNSWEEP\BACKUP

The Transport Wizard defaults to the first "removable" drive on your computer, 
typically drive A:. This destination is the intermediate location, used to transport the 
file from one computer to another.

You can choose a different destination by editing the displayed folder/directory name 
or drive, or by clicking the … button (the Browse button) to browse for a different 
destination.

2 Click the Next button (Alt+N) to store the package in the currently selected 
destination.

When you select a new backup folder or directory, CleanSweep uses it one time only 
and does not save the change for the next package. To change the default backup 
folder or directory permanently, use the Options tab, as described in Changing the 
Default Backup Folder.



Reviewing your Selection
After you have selected an item to package and selected safety precautions, the Wizard displays 
a summary of what it is about to do. The summary notes which file or files will be packaged and 
the number of bytes of disk space that will be packaged.

The View button on this screen displays a description and the safety level of each file that 
CleanSweep believes is associated with your choice. You may be able to view some files to be 
sure you want to package them. You can also change or print the list of displayed files before you 
continue. 

If you are sure you want to package all the files listed, continue with Packaging.

Related Topics:
Examining the List in More Detail



Examining the List in More Detail
After you have selected an item to package and selected safety precautions, CleanSweep 
displays a summary of what it is about to do.

To examine the list closely:

· Click the View button (Alt+V).

The Select the Components dialog box displays the title of the folder or group (if any),
and the filenames and related components to be packaged. The files and 
components are grouped by their "parent" program.

The Wizard uses Windows file viewers to let you take a quick peek at a file without 
having to launch the application that created it. After you have verified the file's 
contents, you can better decide whether you wish to package it. 

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active. You can
use the Run button to launch the program if you want to see what it does.

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active. You can use the Link 
button to display a description of any DLL the file uses, or any programs that depend 
upon that file.

2 Click the View or Run button (Alt+V) or (Alt+R).

The file appears (or the program launches if you clicked Run).

Windows 95 users:    If the file does not display properly, you may have to install the Windows 95
Quick View file viewers from the Windows 95 CD-ROM. For installation instructions, see your 
Windows 95 documentation or A Note on Viewers.

To see a file description without launching the file:

· Select the filename in the list.

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to package, you should clear their check boxes.

To prevent a file from being packaged:

· Clear the check box by clicking on it.

To add a file to the list:

1 Click the Add button (Alt+A). 



The Add Component dialog box appears.

2  Type a filename in the file entry area, then click OK.

You might want to print the list so you can cancel the process and verify each file on your own, or,
you might keep the printout as a record of what you packaged.

To print the list:

1 Click the Print List button (Alt+P).

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list and then click OK. 



Packaging
After you have selected an item to package, selected safety precautions, and reviewed the 
summary information, you are ready to package.

To package the program:

1 Click the Finish button (Alt+F).

That's all there is to it. CleanSweep creates a compressed file.    

If you want to see more details on what CleanSweep did, you can view a summary, 
as described in Viewing a Summary.

2 When you have finished viewing the summary, click the OK button.



Viewing a Summary
When the package is complete, a dialog box reports the action as completed, and asks if you 
want to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears. The text window contains a detailed description of the 
actions performed, including the following:

· Date and time that the action was performed

· Object that was packaged

· Package destination

· Title of the folder or program group, if applicable

· Title of the program and the complete pathname for each program in the folder 
or group 

· Description of the program 

· Number of bytes packaged. 

To print the report:

· Click the Print button (Alt+P).

The report is printed.

To save the report in a file:

1 Click the Save button (Alt+S).

The Save Summary dialog box appears.

2 Type a filename for the report, then click Close (Alt+C).    (Click OK if you are using 
Windows 3.1 or Windows NT.)

Windows 95 and NT use 
C:\PROGRAM FILES\CLEANSWEEP\SAVEREP.TXT 

as the default report filename. 

Windows 3.1 and 3.11 uss C:\CLNSWEEP\SAVEREP.TXT 
as the default report filename.

To change the report filename permanently, use the Options tab as described in 
Changing the Default Report File.

To close the report:



· Click the Close button (Alt+C).

The report closes.

MORE INFO:  The summary report describes only the activity that has just been performed. For a
report on all of CleanSweep's activity, take a look at the Master Log report, as described in 
Viewing the Master Log.



Overview
In this topic you will learn how to:

· Move a program and all of its associated components to another directory on your computer.

· Move a program and all of its associated components from your computer to a network, or 
vice versa.

· View a summary report of what was moved.    

You can use the Move Wizard to relocate programs quickly and easily without reinstalling and 
reconfiguring.    When you move a program, all its related files are relocated to appropriate 
locations and all Windows settings are updated to reflect the new location.

The basic steps to moving a program are:

1. Run the Move Wizard

2. Select the program or folder/group to move

3. Select a destination

4. Review your selection

5. Move the program or folder/group.

The following Help topics describe these steps in detail.



Running the Move Wizard
To run the Move Wizard:

· Click the Move Wizard icon (Alt+M) in the CleanSweep Program tab.

In Windows 95, the Wizard displays a program tree that contains the following 
expandable folders: 

· a folder containing the programs on the Windows 95 Start menu 

· a Desktop folder that contains any desktop shortcut icons

· a folder containing any programs that have been monitored by CleanSweep's 
Install Monitor. (If you have not yet monitored any program installations, the 
folder is empty and the folder's description is "No programs monitored by Install 
Monitor.") 

You can expand these folders and select their subfolders or a program within a folder.
The plus and minus buttons expand and collapse the branches of the folder tree.

In Windows 3.1, 3.11, and NT, the Move Wizard displays the Windows program 
groups in alphabetical order.    

In Windows 3.1x, the program tree also includes a program group that contains a list 
of programs previously monitored by the Install Monitor. (If you have not yet 
monitored any program installations, the program group is titled "No programs 
monitored by the Install Monitor.") 

The Wizard will guide you through the moving process.

To find other folders or programs on your hard drive:

· Click the Find button (Alt+F) , and then skip ahead to Finding Files.



Finding and Selecting a Folder or Program
The methods you can use to find and select a program are:

· Select a program from a folder or group.

· Select all of the programs contained in a folder or group.

· Browse or search for a program and then select it.

Related Topics:
Opening and Closing a Folder/Group
Selecting From a Folder or Program Group
Selecting a Folder or Program Group
Finding Files



Opening and Closing a Folder/Group
In Windows 95, the folders in the Move Wizard's main window are expandable/collapsible. The 
plus sign to the left of a folder indicates that it contains subfolders. The subfolders contain 
program items or other subfolders. When you expand a subfolder you can collapse it; that is, 
close it so only the "parent" folder appears.

To display a folder's contents in Windows 95:

· Click the plus sign.

The folder expands and its subfolders appear. The plus sign changes to a minus sign.

To close a folder in Windows 95:

· Click the minus sign.

The subfolders disappear. The minus sign changes to a plus sign.

In Windows 3.1, 3.11, and NT, the program groups in the main window are 
expandable/collapsible.    The program groups contain program items.    

To view a program group's subdirectories, double-click the program group and its 
subdirectories appear. The subdirectories contain program items. 

To close the program group, double-click it again.

Note:    If you cannot locate a file in a folder or program group, see Where is That File?



Selecting From a Folder or Program Group
Use this method to select a program in a folder or group from the Move Wizard's main window.

To select a program from a folder:

1 Double-click the folder/group that contains the program.

2 Select the program by clicking it.

3 Click the Next button (Alt+N), or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components. CleanSweep then asks for a destination; see Selecting a 
Destination.



Selecting a Folder or Program Group
Use this method to select the entire contents of a folder or program group from the Move Wizard's
main window.

To select the entire folder or program group:

1 Click the folder or group.

The folder or group is selected.

2 Click the Next button (Alt+N), or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components. CleanSweep then asks for a destination; see Selecting a 
Destination.



Finding Files
The methods described in this section locate individual files, rather than entire programs or 
program folders/groups. These methods can help if you wish to find a program, but cannot 
remember where it is stored or if you want to find orphaned or DOS programs using the Move 
wizard.

You may also use the Cleanup tab to search for specific file types, such as duplicate, unused, or 
orphaned files. For more information, see Finding Unneeded Files.

Related Topics:
Browsing For a Program
Searching for a Program



Browsing For a Program
Use this method to select any single file from a folder/group or directory.

To browse for a program:

1 Click the Find button (Alt+F).

2 Click the Browse button (Alt+B).

The Browse for a Program dialog box appears. The main window in this dialog 
displays a scrollable list of files and folders, arranged alphabetically by name¾folders
or directories first, and then the files.

Windows 95 users:    The following procedures describe how to browse for and select a program
in Windows 95.

1 To move up a level in the "folder tree," click the Up One Level button on the toolbar. 

To look in a folder/group above the current one, or to look on another drive, click the 
Look in list box (Alt+I). To look in a folder within the current folder, double click the 
folder in the main window below the Look in box.

To see more details about the files and folders in the main window, click the Details 
button on the toolbar.

2 Select a file or type a filename in the File name entry field. 

In Windows 95, a filename can be more than eight characters, and may contain 
periods, commas, hyphens, exclamation points, and spaces. If you do not know the 
entire filename, you can use the asterisk (*) or question mark (?) as wildcard 
characters. The dialog box displays only program files by default. To display all file 
types, click the Files of type list box, and then select All Files (*.*).

3 Click the Open button (Alt+O).

The Wizard does a quick analysis of the file, then asks for a destination. See 
Selecting a Destination.

Windows 3.1, 3.11, and NT users: The following procedures describe how to browse for a file in 
Windows 3.1, 3.11, and Windows NT.

To change drives:

 · Click the drop-down button in the Drives drop-down list box (Alt+V) and then make 
another selection.

To change directories:

· Double-click the directory name in the Directories list box (Alt+D).

To select a file:



1 Click the filename.

2 Click the OK button.

The Wizard does a quick analysis of the file, then asks for a destination. See 
Selecting a Destination.



Searching for a Program
Use this method to locate a single file from a list of specific program types, including all programs,
DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Click the Find button (Alt+F) on the Move Wizard's main window.

2 Click the Search button (Alt+S) .

The Search for a Program dialog box appears. 

3 The Wizard searches all local hard drives by default. To specify another drive to 
search, click the Drives To Search: box (Alt+D), select one or more drives from the 
dialog box, then click OK.

4 The Wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click the drop-down button in the Files of Type list box (Alt+T) 
then choose Windows Programs, DOS Programs, or Dynamic Link Libraries.

5 Use the scroll bar to move up and down the file list, and then click the filename to 
select it. You may only select one program at a time.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and the file's size in bytes.      

6 After you have selected a file, click OK.

The Wizard does a quick analysis of the file, then asks for a destination.    See 
Selecting a Destination.



Selecting a Destination
After you have selected an item to move, CleanSweep asks where you want to store it.

To select a destination:

1 Click the Next button (Alt+N).

A dialog box provides an input area for the destination.

You can type a destination name or choose a different destination by clicking the … 
button (the Browse button) and browsing for a different destination.    The destination 
can be a floppy or other "removable" drive, a directory or folder on your hard drive, a 
network drive, or a CD-ROM drive.

2 Click the Next button (Alt+N) to move the package to the currently selected 
destination.



Reviewing your Selection
After you have selected an item to move and a destination, the Move Wizard displays a summary 
of what it is about to do. The summary notes which file or files will be moved and the number of 
bytes that will be moved.

The View button on this screen displays a description and the safety level of each file that 
CleanSweep believes is associated with your choice. You may be able to view some files to be 
sure you want to move them. You can also change or print the list of displayed files before you 
continue. 

If you are sure you want to move all the files listed, continue with Moving.

Related Topics:
Examining the List in More Detail



Examining the List in More Detail
After you have selected an item to move and a destination, the Move Wizard displays a summary 
of what it is about to do. 

To examine the list closely:

· Click the View button (Alt+V).

The Select the Components dialog box displays the title of the folder or group (if any),
and the filenames and related components to be moved. The files and components 
are grouped by their "parent" program. By default, CleanSweep will preselect for 
moving all files with a green safety level¾all files that CleanSweep is sure can be 
moved safetly.    Files with a yellow safety level are also candidates for moving, but 
CleanSweep will not move them unless you specifically select them.    When you add 
a file or component to the list (see below), CleanSweep displays its safety level as 
blue, indicating that CleanSweep has not given its own safety level to the file.

The Wizard uses Windows file viewers to let you take a quick peek at a file without 
having to launch the application that created it. After you have verified the file's 
contents, you can better decide whether you wish to move it.    This adds another 
layer of safety to the moving process. 

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active. You can
use the Run button to launch the program if you want to see what it does.

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active. You can use the Link 
button to display a description of any DLL the file uses, or any programs that depend 
upon that file.

2 Click the View or Run button (Alt+V) or (Alt+R).

The file appears (or the program launches if you clicked Run).

Windows 95 users:    If the file does not display properly, you may have to install the Windows 95
Quick View file viewers from the Windows 95 CD-ROM. For installation instructions, see your 
Windows 95 documentation or A Note on Viewers.

To see a file description without launching the file:

· Select the filename in the list.

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to move, you should clear their check boxes.

To prevent a file from being moved:



· Clear the check box by clicking on it.

You may want to move some files that are not on the list.

To add a file to the list:

1 Click the Add button (Alt+A). 

The Add Component dialog box appears.

2  Type a filename in the file entry area, then click OK.

You might want to print the list so you can cancel the process and verify each file on your own, or,
you might keep the printout as a record of what you moved.

To print the list:

1 Click the Print List button (Alt+P).

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list, then click OK. 



Moving
When you have selected an item to move and reviewed the summary information, you are ready 
to move the program.

To move the program:

1 Click the Finish button (Alt+F).

That's all there is to it. CleanSweep moves the program.    

If you want to see more details on what CleanSweep did, you can view a summary, 
as described in Viewing a Summary.

2 When you have finished viewing the summary, click the OK button.



Viewing a Summary
When the move is complete, a dialog box reports the action as completed, and asks if you want 
to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears. The text window contains a detailed description of the 
actions performed, including the following:

· Date and time that the move was performed

· Object that was moved

· Destination

· Title of the folder or program group, if applicable

· Title of the program and the complete pathname for each program in the folder 
or group 

· Description of the program 

· Number of bytes moved. 

To print the report:

· Click the Print button (Alt+P).

The report is printed.

To save the report in a file:

1 Click the Save button (Alt+S).

The Save Summary dialog box appears.

2 Type a filename for the report, then click Close (Alt+C).    (Click OK if you are using 
Windows 3.1 or Windows NT.)

Windows 95 and NT use 
C:\PROGRAM FILES\CLEANSWEEP\SAVEREP.TXT 

as the default report filename. 

Windows 3.1 and 3.11 use
 C:\CLNSWEEP\SAVEREP.TXT 
as the default report filename.

To change the report filename permanently, use the Options tab as described in 
Changing the Default Report File.



To close the report:

· Click the Close button (Alt+C).

The report closes.

MORE INFO:  The summary report describes only the activity that has just been performed. For a
report on all of CleanSweep's activity, take a look at the Master Log report, as described in 
Viewing the Master Log.



Overview
In this topic you will learn how to find and clean up:

· Duplicate files.

· Redundant DLL or VBX files.

· Unused or infrequently used files.

· Orphan files (files left behind by applications that have been deleted).

If you have tried to remove programs without using CleanSweep, you probably have a large 
number of stray files remaining on your hard drive. Even after you have used CleanSweep to 
remove programs, your hard disk may still contain outdated or unneeded data files. 
CleanSweep's Finders can help to locate these types of    files for you.

The basic steps for removing unneeded files are:

1 Choose a Finder from the Cleanup tab.

2 Determine which files are no longer needed.

3 Select the unneeded files.

4 Tell CleanSweep what to do with the files you selected.



Selecting a Finder
To select a Finder:

1 Click the Cleanup tab.

The Cleanup tab shows the Finders.

2 Click the icon for the desired Finder.

Finder What it Does

Duplicate File Finder Finds duplicate copies of files by name 
and size, or by criteria that you specify.

Redundant DLL Finder Finds DLL (Dynamic Linked Library) and 
VBX (Visual Basic exension) files that 
exist in more than one location.

Unused File Type Finder Finds type of files that are typically 
unused, for example, screen savers, 
backup files, or fonts.

Low File Usage Finder Displays files based on the number of 
times they have been accessed.

Orphan Finder Finds files related to applications that are
no longer installed on your computer.    In
Windows 95, CleanSweep considers a 
program an orphan file if it is not on the 
Start menu. An orphaned file could also 
be a program that is not associated with 
or attached to the Windows shell.

Refer to the following topics for instructions on how to use each Finder.



Finding Duplicate Files
Use the Duplicate File Finder to locate and remove files with the same name. Duplicate files may 
be caused by installations of the same program into different folders or directories, or by copying 
the contents of a folder or directory from one location to another. You may have edited a file in 
one folder or directory and saved the updated version to another folder or directory. By removing 
duplicate files, CleanSweep can free valuable hard disk space and improve performance. 

To find duplicate files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Duplicate File Finder icon (Alt+D).

IMPORTANT:    When you click the Duplicate File Finder icon, CleanSweep scans your computer 
for duplicate files.    Do not interrupt this scanning process to ensure the most complete duplicate 
file information.

The Duplicate File Finder window appears.

Related Topics:
Defining the Search Criteria
Selecting the Drive to Search
Selecting the File Type
Selecting Files



Defining the Search Criteria

Before you select duplicate files, you may wish to revise the criteria CleanSweep will use to 
determine whether files are duplicates.

To define the file search criteria:

1 Click the Search For drop-down button (Alt+E).

The list of search criteria choices appears.

Search Criteria What it Finds

Files with the same name and size Finds files with the same name and size.
This is the default selection.

Files with the same name, size, date, 
and time

Finds files with the same name, size, 
date, and time. This is the most restricted
search. When you find duplicate files, 
review CleanSweep's advice to see 
which duplicate file had the last access.

Files with the same name only Files with the same name will be listed, 
regardless of size, date, or time. This is 
the least restricted search. 

2 Click the desired search criteria.

Note: Two files with the same name are not necessarily duplicates. If two files have the same 
size, date, and time, then there is a high probability that they are identical and you can safely 
delete one of them. If two files have the same name but do not have the same size, date, and 
time, the newer one is normally more up-to-date, and the older one is the better candidate for 
removal. There is no guarantee that files with the same name are identical or even related to one 
another. You can use the View button to view the files and determine which files are duplicates 
and which are unique.



Selecting the Drive to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drive to search:

1 Click the Drives to Search box (Alt+D).

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



Selecting the File Type

Use the Files of Type option to limit the search for duplicate files in specific categories.

To select the file type:

1 Click the Files of Type drop-down button (Alt+T). 

The list of file type choices appears.

File Type Searches For

All Files Duplicate file of all types. This is the 
default selection. It finds the most files, 
but takes the longest time.

(Add Custom File Type) Files with specific file extensions. Type 
the file extension, or a list of extensions, 
in the Add Custom File Type dialog.

Programs BAT, COM, EXE, or PIF (Windows 
Program Information File) files.

Dynamic Link Libraries DLLs and VBXs

IMPORTANT:    Use caution when deleting duplicate BAT, COM, or EXE, DLL, or VBX files. Some
programs may require particular versions of these files to run properly. Although CleanSweep will 
prevent you from deleting files that are essential to the operation of DOS or Windows, you should 
always make a backup of programs and DLLs.

2 Click the desired file type or choose Add Custom File Type to enter a specific file 
extension.



Selecting Files

The scrollable list shows the names, size, path, date, and time of the duplicate files CleanSweep 
has found. It also lists the number of times the files have been accessed since CleanSweep's 
Usage Monitor has been enabled (the default number is 1). Beside each listed file is a yellow box 
indicating that duplicate files should be deleted with caution. Below the file list is an icon that tells 
you the kind of file that is currently highlighted. You can select any file from the list and mark it for 
deletion. You can also have CleanSweep give you more information about the file so you can 
decide what to do with it.

To select duplicate files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that a checkmark appears in its check box. While the file
is highlighted, you may choose to display more information about it (see the next 
topic).

3 To deselect a single file, click anywhere on its line to remove the checkmark. To 
deselect all files, click the Deselect All button (Alt+S).

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

The following actions are available in the Duplicate File Finder.

Action What it Does

Clean Begins the backup and deletion process. Clean provides several 
options for handling selected files (see Cleaning Up Unneeded 
Files). This option applies to all selected files and is only available if 
there are files selected.

Advise Offers a summary describing the highlighted file in more detail, and 
advice on what to do with it.

View Activates a Windows viewer or launches an application for the 
highlighted file.If the file is in a format unknown to Windows, but 
contains mostly text, the contents of the file are displayed. For most 
Windows application and system files, a summary of information 
from the file's header is displayed. The button is only active if a file 
is highlighted in the scrolling window.

Links Activates a dialog that lists files that use this file, or files that this file 
uses. This button is activated only if a DLL, EXE or VBX file is 
selected.

Run Executes the highlighted file. This button is activated only if the 
selected file is executable (BAT, COM, EXE, or PIF), or is 
associated by Windows with a specific application.

Deselect All Deselects all selected files in the scrolling window.

IMPORTANT:    It is usually unwise to remove all copies of a duplicated file. You should determine
which files are needed and delete only the unneeded files. Always make a backup if you are not 
certain the file may be safely deleted.





Finding Redundant DLL Files
Use the Redundant DLL Finder to locate and remove duplicate DLL or VBX files. DLL (Dynamic 
Link Library) and VBX (Visual Basic extension) files can contain program code or other kinds of 
resources such as icons, bitmaps, controls, and dialogs, and can be used by one or more 
applications. 

Windows programming tools often include copies of useful (and sometimes very large) DLLs that 
can be distributed as part of the finished application. While the installation routines for some 
products are intelligent enough to check your system for pre-existing copies of common DLLs, 
many are not so bright and instead install yet another copy. Therefore, you can have multiple 
copies of the same file taking up the dwindling space on your hard disk.

To find redundant DLL and VBX files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Redundant DLL Finder icon (Alt+R).

The Redundant DLL Finder window appears.

Related Topics:
Selecting the Drives to Search
Selecting DLL or VBX Files



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drive to search:

1 Click the Drive to Search field (Alt+D). 

The Select Drive dialog box appears.

2 Click the desired drive to search.

3 Click OK to confirm your drive selection.



Selecting DLL or VBX Files

The scrollable list shows the name, path, version, date, and time of each redundant DLL or VBX 
file, and the number of times the file has been found. It also lists the number of times the files 
have been accessed since CleanSweep's Usage Monitor has been enabled (the default is 1). 
Files are listed alphabetically. Beside each listed file is a box, color-coded to indicate the safety 
level associated with deleting the file. 

A red box signifies that the file is in use or protected and cannot be deleted. 

A yellow box appears next to files that have the same name as a file in the \WINDOWS or \
WINDOWS\SYSTEM directory, but which are not the same version. Such files should be deleted 
with caution. 

A green box indicates that the file is clearly redundant, and can be removed safely. In the 
Redundant File Finder, such files are preselected for deletion. 

A blue box indicates that CleanSweep has not given its own safety level to the file.    A blue box 
might also indicate that the file is a newer version than the same named file in the \WINDOWS or 
WINDOWS\SYSTEM directory.    These files cannot be selected.

To select DLL or VBX files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that a checkmark appears in its check box. While the file
is highlighted, you may choose to display more information about it (see the next 
topic).

3 To deselect a single file, click its yellow or green box. 

4 To deselect all files, click the Deselect All button (Alt+S).

5 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

IMPORTANT:    Use caution when deleting redundant DLL or VBX files. Some programs may 
require particular versions of the DLL or VBX files to run properly. Always make a backup copy of 
the files you are deleting.

The following actions are available in the Redundant DLL Finder.

Action What it Does

Clean Begins the backup and deletion process. Clean provides several 
options for handling selected files (see Cleaning Up Unneeded 
Files). This option applies to all selected files and is only available
if there are files selected.

Advise Offers a summary describing the highlighted file in more detail, 
and advice on what to do with the highlighted file.



View Activates a Windows viewer or launches an application for the 
highlighted file.    If the file is in a format unknown to Windows, but
contains mostly text, the contents of the file appears. For most 
Windows application and system files, a summary of information 
from the file's header appears. The button is active only if a file is 
highlighted in the scrolling window.

Links Activates a dialog that lists files that use this file, or files that this 
file uses. This button is activated only if a DLL, EXE or VBX file is 
selected.

Deselect All Deselects all selected files in the scrolling window.

Finding Unused Files by Type
Many of the files on your system will be of similar types. For example, you may keep spreadsheet
files over a period of several years, or you may download files of clipart from a BBS or from the 
Internet. As you make and move copies of these files on your hard drive, you may find that many 
files of similar types¾denoted by file extensions¾are never used and can be deleted safely. Use 
the Unused File Type feature to select files in categories that CleanSweep already knows, or 
create your own file categories and add them to CleanSweep's list. 

To find unused files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Unused File Finder icon (Alt+U).

The Unused File Type Finder window appears.

IMPORTANT:    When you click the Unused File Finder icon, CleanSweep scans your computer 
for unused files. Do not interrupt this scanning process to ensure the most complete unused file 
information.

Related Topics:
Selecting the File Type
Selecting the Drives to Search
File Information



Selecting the File Type
The scrollable list at the top of the window provides a list from which you can select various 
categories of files (archive files, display drivers, fonts, etc.). CleanSweep displays the number of 
files and the total size of the files in each category.    For each file category the number of files and
the cumulative size of the files is listed. CleanSweep also uses color to display the safety level of 
each type of file. In some categories, different files might have different safety levels; for such 
categories, multiple safety levels will be displayed.

The scrollable list displays individual files of the type selected in the top list.

To select a file type:

· Click the file type you wish to display.

The unused files appear in the lower list.



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drives to search:

1 Click the Drives to Search field (Alt+D). 

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



File Information

The lower scrollable list shows the name, size, path, date, and time of each file in the category 
selected above. It also lists the number of times the files have been accessed since 
CleanSweep's Usage Monitor has been enabled (the default number is 1). Beside each listed file 
is a box, color-coded to indicate the safety level associated with deleting the file. 

A red box signifies that the file is in use or protected, and may not be deleted. 

A yellow box appears next to files that CleanSweep believes may be unsafe to remove. Such files
should be deleted with caution. 

A green box indicates that the file is clearly redundant, and can be removed safely. Such files are 
preselected for deletion. 

To select unused files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that a checkmark appears in its check box. While the file
is highlighted, you may choose to display more information about it (see the next 
topic).

3 To deselect a single file, click its yellow or green box. To deselect all files, click the 
Deselect All button (Alt+S).

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

Action What it Does

Clean Begins the backup and deletion process. Clean provides several 
options for handling selected found files (see Cleaning Up 
Unneeded Files). This option applies to all selected files and is 
only available if there are files selected.

Advise Offers a summary describing the highlighted file in more detail, 
and advice on what to do with it.

Custom Provides a dialog for specifying a custom file search string. For 
example, you could specify *.ASC to search for all files with 
the .ASC extension, or *.WK1 to find all of your Lotus 2.x 
spreadsheets. You can specify more than one extension to 
search for by separating each extension with a space. You can 
also use the DOS wildcards (* and ?) in the custom file search 
string.    CleanSweep stores this information between sessions. 
Use this feature to customize CleanSweep's Unused File Type 
Finder to suit your needs.

View Activates a viewer for the highlighted file. If the file contains text, 
the contents of the file are displayed. For most Windows 
application and system files, a summary of information from the 
file's header appears. This button can only be selected if a file is 
highlighted in the scrolling window.

Links Activates a dialog that lists files that use this file, or files that this 
file uses. This button is activated only if a DLL or VBX file is 



selected.
Run Executes the highlighted file. This button is activated only if the 

selected file is executable (BAT, COM, EXE, or PIF), or if the file 
is associated by Windows with a specific program.

Select All Selects all files in the scrolling window.
Deselect All Deselects all files in the scrolling window.

Finding Infrequently Used Files
CleanSweep's File Usage Monitor makes a note each time you use a file on your computer, and 
stores a table of this information for the Low Usage File Finder. Use this feature to list files based 
on how many times they have been accessed since they were created (or since you installed 
CleanSweep). Note, however, that the information displayed by the Low Usage File Finder is only
accurate if the File Usage Monitor is enabled constantly on your computer.

IMPORTANT:    The CleanSweep Usage Monitor must be installed and running for this function to 
report accurate access information. for more information on the Usage Monitor, including how to 
have it alert you of unused files, see Configuring the Usage Monitor (Windows 3.1x and 95 only).

To find infrequently used files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Low File Usage Finder icon (Alt+L).

IMPORTANT:    When you click the Low File Usage Finder icon, CleanSweep scans your 
computer for infrequently used files. Do not interrupt this scanning process to ensure the most 
complete low file usage information.

The Low File Usage Finder window appears.

Related Topics:
Selecting File Sorting Options
Selecting File Sorting Order
Selecting the Drives to Search
Selecting a File Type
File Information



Selecting File Sorting Options

CleanSweep can display its list of files based on criteria you choose.

To select the file sorting option:

1 Click the Sort files by drop-down button (Alt+S). 

The file sorting options appear.

Sort Option What it Does

Size Sorts files by size.
Access Sorts files by access count.
Last Access Date Sorts files by the last time they were accessed (note 

that this is not necessarily the last time they were 
changed).

Last Change Date Sorts files by the last time they were changed.
File Name Sorts files alphabetically by filename.
Type Sorts files by type (file extension).
Unsorted Displays the files in unsorted form.

2 Select the desired sort option or choose Unsorted to display the files without sorting 
them.



Selecting File Sorting Order

The default sort order is ascending order. You can switch to descending order if you wish.

To switch to descending order:

· Click the Sort Files In drop-down list (Alt+I), then select Descending Order.



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or a network drive.

To select the drives to search:

1 Click the Drives to Search field (Alt+D). 

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



Selecting a File Type

Use the Files of Type option to limit the search for duplicate files in specific categories.

To select the file type:

1 Click the Files of Type drop-down button (Alt+T). 

The list of file type choices appears. 

File Type Searches For

All Files Infrequently used files of all types. This is the 
default selection. It finds the most files, but 
takes the longest time.

(Add Custom File Type) Files with a specific file extensions. Type the 
file extension, or a list of extensions, in the 
Add Custom File Type dialog.

Programs BAT, COM, EXE, or PIF (Windows Program 
Information File) files.

Dynamic Link Libraries DLLs and VBXs.

2 Click the desired file type or choose Add Custom File Type to enter a specific file 
extension.



File Information

The scrollable list shows the duplicate files and their locations, sizes, dates, and times. It also lists
the number of times the files have been accessed since CleanSweep's Usage Monitor has been 
enabled (the default number is 1). Below the file list is an icon that tells you the kind of file that is 
currently highlighted. You can select any file from the list and mark it for deletion. You can also 
have CleanSweep give you more information about the file so you can decide what to do with it.

To select infrequently used files:

1 Click the check box beside the pathname for the selected file. Any file, regardless of 
how frequently it is used, could be important and should be deleted with caution. For 
this reason, CleanSweep displays the safety level of each file as yellow.

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that a checkmark appears in its check box. While the file
is highlighted, you may choose to display more information about it (see the next 
topic).

3 To deselect a single file, click anywhere on its line to remove the checkmark. To 
deselect all files, click the Deselect All button.

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

The following actions are available in the Duplicate File Finder.

Action What it Does

Clean Begins the backup and deletion process. Clean provides several 
options for handling selected files (see Cleaning Up Unneeded 
Files). This option applies to all selected files and is only 
available if there are files selected.

Advise Offers a summary describing the highlighted file in more detail, 
and advice on what to do with the highlighted file.

View Activates a Windows viewer or launches an application for the 
highlighted file. If the file is in a format unknown to Windows, but 
contains mostly text, the contents of the file are displayed. For 
most Windows application and system files, a summary of 
information from the file's header appears. The button is only 
active if a file is highlighted in the scrolling window.

Links Activates a dialog that lists files that use this file, or files that this 
file uses. This button is activated only if a DLL or VBX file is 
selected.

Run Executes the highlighted file. This button is activated only if the 
selected file is executable (BAT, COM, EXE, or PIF).

Deselect All Deselects all selected files in the scrolling window.

Finding Orphaned Files
When you delete an application from your computer without a program like CleanSweep, there is 



a good chance that your computer will require some tidying up. Use the Orphan Finder to list 
stray files and file associations in WIN.INI, or files related to applications that are no longer on 
your computer. 

To find orphan files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Orphan Finder icon (Alt+O).

The Orphan Finder window appears.

IMPORTANT:    Make sure you do not delete files that are required by applications on CD-ROM. 
False orphans may appear if your computer does not have access to a particular CD-ROM that 
uses the files at the time you run the Orphan Finder.

Related Topics:
Selecting the Orphan Type
Selecting the Drives to Search
Selecting Orphan Files



Selecting the Orphan Type

The scrollable list at the top of the window gives a list from which you can select various 
categories of orphan files. CleanSweep displays the number of files and the total size of the files 
in each category. CleanSweep also uses color to display the safety level of each type of file.

Orphan Type Definition

Empty Groups Groups within your Windows shell which no 
longer contain any icons.

Orphan DLLs DLLs that may have been left behind when their 
associated programs were deleted.

Orphan File Associations In WIN.INI, entries that tell Windows which 
program to run when a given document file is 
launched, but for which the program is missing.

Orphan Icons Icons in your shell which are invalid because the 
programs to which they refer have been deleted.

Orphan INI Files INI (initialization) files which are no longer useful 
because the programs to which they refer have 
been deleted

Orphan OLE Embeddings Entries in the OLE (Object Linking and 
Embedding) database which are no longer valid 
because they are associated with a    program that
has been deleted.

Orphan OLE Objects Entries referrring to OLE in the Registry that are 
no longer valid because they are associated with 
a program that has been deleted.

Orphan Programs Windows programs that are not associated with or
attached to the Windows shell. In Windows 95, 
CleanSweep considers a program an orphan file if
it is not on the Start menu or one of its submenus,
and does not reside in the same folder as a file 
that is on the Start menu or one of its submenus

Zero-Byte Files Files that have a size of 0.

IMPORTANT: Orphan Windows programs may be useful, or may be parts of other programs on 
your system, even though they don't have icons associated with them in your shell. Note also that
some DOS programs may be displayed as Windows programs here; because such programs are 
stored in the same file format as Windows programs. For these reasons, use care when deleting 
orphan programs, and always make a backup.



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or a network drive.

To select the drives to search:

1 Click the Drives to Search window (Alt+D). 

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



Selecting Orphan Files

The scrollable list shows the name, size, path, date, and time of each orphan file in the category 
selected above. It also lists the number of times the files have been accessed since 
CleanSweep's Usage Monitor has been enabled (the default number is 1). Beside each listed file 
is a box, color-coded to indicate the safety level associated with deleting the file. 

A red box signifies that the file is in use or protected, and may not be deleted. 

A yellow box appears next to files that CleanSweep believes may be unsafe to remove. Such files
should be deleted with caution. 

A green box indicates that the file or association is clearly useless, and can be removed safely. 

A blue box indicates that CleanSweep has not given its own safety level to the file.

To select orphan files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that a checkmark appears in its check box. While the file
is highlighted, you may choose to display more information about it (see the next 
topic).

3 To deselect a single file, click its yellow or green box. To deselect all files, click the 
Deselect All button (Alt+D).

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

Action What it Does

Clean Begins the backup and deletion process. Clean provides several 
options for handling selected files (see Cleaning Up Unneeded 
Files). This option applies to all selected files and is only 
available if there are files selected.

Advise Offers a summary describing the highlighted file in more detail, 
and advice on what to do with it.

Attach Activates a dialog for adding the selected executable file (EXE 
only) to    a new folder or program group. CleanSweep can add a
program to an existing group or can create a new program group
for you.

View Activates a Windows viewer, if one is available, or launches an 
application (such as WordPad or NotePad) for the highlighted 
file. For most Windows application and system files, a summary 
of information from the file's header appears. The button is only 
active if a file is highlighted in the scrolling window.

Links Activates a dialog that lists files that use this file, or files that this 
file uses. This button is activated only if a DLL or VBX file is 
selected.

Run Executes the highlighted file. This button is activated only if the 
selected file is executable (BAT, COM, EXE, or PIF), or if the file 
is associated by Windows with a specific program.



Select All Selects all files in the scrolling window.
Deselect All Deselects all files in the scrolling window.

MORE INFO:    See Cleaning Up Unneeded Files for details on how to use the Clean options.



Cleaning Up Unneeded Files
After you find and select items in a Finder window, you can click the Clean button (Alt+C) to start 
the backup and deletion process. CleanSweep is designed to remove unneeded files and 
associations safely, and the Clean function has several safeguards built in to keep you from 
permanently losing any programs, files, or settings that you discover later are important. You can 
also create archives of your programs without deleting them, and keep a record of any changes 
that CleanSweep makes to configuration files or system settings.

The five ways to clean up files are to:

· Delete them

· Archive them

· Back them up

· Move them

· Transport them

Related Topics:
Deleting files
Archiving files
Backing up files
Moving files
Transporting files



Deleting files

Choose the Delete them selection (Alt+D) to remove files and optionally create a backup copy of 
them. Delete is the default selection.

IMPORTANT:    CleanSweep provides safeguards to prevent the loss of essential programs and 
files. However, we always recommend that you back up files before deleting them to make sure 
they can be recovered if you experience problems. 

To delete files and make a backup copy:

1 Click Clean (Alt+C) in a Finder window.

2 Click Next (Alt+N).

3 Select whether or not a backup should be created, then click Next (Alt+N).

4 Click Next (Alt+N) to confirm or change the destination for the backup. 

In Windows 95 and NT, the default folder is C:\PROGRAM FILES\CLEANSWEEP\
BACKUP.    

In Windows 3.1x, the default backup directory is C:\CLNSWEEP\BACKUP.

To change the backup folder or send the backup to a floppy disk, or other drive, type 
the new directory or drive name (for example, A: or C:\BACKUP) in the space 
provided.

5 To confirm each deletion, choose Yes (Alt+Y). Click Next (Alt+N) to delete the files 
without confirming each deletion. 

6 Click View (Alt+V) to look at a list of files to delete. Click Finish (Alt+F) to delete the 
files. 

To delete files without making a backup copy:

1 Click Clean (Alt+C) in a Finder window.

2 Click Delete them (Alt+D), then click Next (Alt+N).

3 Choose No (Alt+O) to opt not to make a backup. Click Next (Alt+N).

4 A dialog box warns you that creating a backup is always recommended. If you are 
sure you do not want a backup, click Yes (Alt+Y).

5 To confirm each deletion, choose Yes (Alt+Y). Click Next (Alt+N) to delete the files 
without confirming each deletion.

6 Click View (Alt+V) to look at a list of files to delete. Click Finish (Alt+F) to delete the 
files. 



 Archiving files

Choose the Archive them selection to compress and back up the selected files. The files are not 
deleted from their original location. CleanSweep creates an icon for the archived items in your 
Windows shell so that you may restore the archive easily.

To archive files:

1 Click Clean (Alt+C) in a Finder window.

2 Click Archive them (Alt+A) and then click Next (Alt+N).

3 Type the folder in which you would like to keep the archive file or click Next to accept 
the default folder. 

In Windows 95 and NT, the default folder is 
C:\PROGRAM FILES\CLEANSWEEP\BACKUP 

In Windows 3.1 and NT, the default backup directory is C:\CLNSWEEP\BACKUP

4 Click View (Alt+V) to look at a list of files to be archived. Click Finish (Alt+F) to 
archive the files.

5 CleanSweep will ask if you wish to create an archive icon. If so, CleanSweep will 
create an icon in the Archives program group in your Windows shell. Clicking on this 
icon will start CleanSweep, and take you automatically to the Restore Wizard.



Backing up files

Use the Back them up selection to back up files without deleting them, and without creating an 
icon as the Archive option does.

To back up files:

1 Click Clean (Alt+C) in a Finder window.

2 Click Back them up (Alt+C), then click Next (Alt+N).

3 Type the name of the folder or directory in which you would like to keep the backup 
file or click Next (Alt+N) to accept the default folder. 

In Windows 95 and NT, the default folder is 
C:\PROGRAM FILES\CLEANSWEEP\BACKUP

In Windows 3.1 and 3.11, the default backup directory is 
C:\CLNSWEEP\BACKUP

4 Click View (Alt+V) to look at a list of files to back up. Click Finish (Alt+F) to back up 
the files. 



Moving files

Use the Move them selection to move files to another folder (directory and/or drive) on your 
computer. The files in the original folder or directory will be deleted.

To move files:

1 Click Clean (Alt+C) in a Finder window.

2 Click Move them (Alt+M), then click Next (Alt+N).

3 Type the name of the folder, or click the …button (the Browse button) to browse for a 
destination folder or directory. Click Next (Alt+N) to accept the folder you have 
chosen.

4 Click View (Alt+V) to see a list of files that are to be moved. Click Finish (Alt+F) to 
move the files.

5 After the files have been moved, you may click Summary to see a report of the 
action that was just performed, or you may click on OK to return to the Cleanup tab.



Transporting files

Use the Transport them selection to copy files to another disk¾typically a floppy disk¾so that 
you can move it easily to another computer (for example, a laptop).

To transport files:

1 Click Clean (Alt+C) in a Finder window.

2 Click Transport them (Alt+T), then click Next (Alt+N).

3 CleanSweep will display the default transport drive, typically A:. Click on the line 
displaying the default drive if you wish to select a different drive.Click Next (Alt+N) to 
accept the currently displayed drive 

4 If you wish, you may click View (Alt+V) to see a list of files that are to be transported. 
Click Finish (Alt+F) to transport the files to the destination drive.



A Note on Viewers (Windows 95 Users)
If you have not installed the Windows 95 QuickView file viewers, CleanSweep may not be able to 
display your files properly. 

Note: The following procedure works if you installed Windows 95 from CD-ROM. If you installed 
Windows 95 from floppy disks, you need to contact Microsoft.

To install the Windows 95 viewers:

1 Click the Windows 95 Start button.

2 Point to Settings (Alt+S), and then click Control Panel (Alt+C).

3 Double-click Add/Remove Programs.

The Add/Remove Programs Properties dialog box appears.

4 Choose the Windows Setup tab.

5 Click Accessories, then the Details button (Alt+D) below.

6 Scroll down until you see Quick View, then select its check box.

7 Click OK, and then follow any instructions.



Overview
In this topic you will learn how to:

· Restore a previously backed up program and its related components.    

· View a summary report of what was restored.

The Restore Wizard uses a CleanSweep backup file to restore files to their original state.    You 
might want to restore files if you uninstalled, archived, or backed up files and later decide that you
want them back.    (CleanSweep creates a backup file during an uninstallation only if you specify 
that it should do so.)    You will also use the Restore Wizard as the final step in moving a program. 

The basic steps to restoring a program are:

1. Run the Restore Wizard

2. Select the program or specific files to restore

3. Specify what to do if older files by the same name exist and whether you want    to have the 
Wizard inform you before it overwrites a file.

4. Review which files will be restored.

5. Restore the program.

The next Help topics describe these steps in detail.



Running the Restore Wizard
To run the Restore Wizard:

1 Click the Restore tab in the CleanSweep main window.

The Restore tab appears.

2 Click the Restore Wizard icon (Alt+R) in the Restore tab.

The Wizard will guide you through the restoring process.    



Selecting a Backup
Once you select the Restore Wizard, you must tell CleanSweep what backup to restore. The 
methods you can use to find and select a backup are:

· Select the last item that was backed up.    This is the default.

· Select a backup from the default backup folder/directory list.

· Browse for a folder or directory and then select a backup from it.

Related Topics:
Selecting the Last Item that was Backed Up
Selecting From the Default Backup Folder/Directory
Browsing for a Backup



Selecting the Last Item that was Backed Up
The first Restore Wizard screen lists the last item that was backed up, and when it was backed 
up. This item is selected by default. Backup files usually contain more than one file. You can take 
a look at what files are contained in the item listed by clicking the Details button.

To restore the last item backed up:

 · Click Next (Alt+N).

A dialog asks if you want to restore all of the files, or if you want to select a portion of 
the backup file. 

To restore another backup file:

 · Click No, let me select another item (Alt+O), then click Next (Alt+N). 

The Restore Wizard displays all backup files in the default backup folder or directory. 



Selecting From the Default Backup Folder/Directory
When you choose No, let me select another item and then click the Next button on the first 
Restore Wizard screen, the Wizard displays all backup files in the default backup folder/directory. 

In Windows 95 and NT, the default backup folder is 
C:\PROGRAM FILES\CLEANSWEEP

In Windows 3.1 and 3.11, the default CleanSweep backup directory is C:\CLNSWEEP\BACKUP

At this point, you can select a backup from the default folder/directory or browse another 
directory.

To select a backup from CleanSweep's default backup folder/directory:

· Click the backup you want to restore, then click Next (Alt+N).

You can take a look at what individual files are contained in the backup file by clicking
the Details button (Alt+D).

You can either choose to restore all the files, or you can remove files from the list to 
restore a portion of the program.



Browsing for a Backup
Use this method to select a backup from a folder or directory other than CleanSweep's default 
backup folder/directory. 

To browse for a backup:

 · Press ... (the Browse button), which appears to the right of the displayed backup 
folder/directory on the first Restore Wizard screen.

The Browse for CleanSweep Backups dialog box appears.

Windows 95 users:    The following procedures describe how to browse for and select a backup 
file in Windows 95. 

To look in another folder or change drives in Windows 95:

1 Click the drop-down button in the "Look in" drop-down list box (Alt+I) and then make 
another selection.

The dialog box lists the backup files in alphabetical order. Backup files have the 
extension BUP, BUD, BUS, BUU, BUB, or BUA.

2 To see more details about the files, click the Details button.

To move up a level in the "folder tree," press the Up One Level button.

3 Select a file or type a filename in the File name entry field. If you do not know the 
entire filename, you can use the asterisk (*) or question mark (?) as wildcard 
characters.

4 Click Open (Alt+O).

5 Click Next (Alt+N).

CleanSweep determines which files are in the backup file and displays a list. You can
either choose to restore all the files, or you can remove files from the list to restore a 
portion of the program. 

Windows 3.1x and NT users: The following procedures describe how to browse for and select a 
backup file in Windows 3.1, 3.11, and NT.

To change drives:

 · Click the drop-down button in the Drives drop-down list box (Alt+V) and then make 
another selection.

To change directories:

 · Double-click the directory name in the Directories list box (Alt+D).

Look through the list of backup files in the File Name list box. By default, the dialog 



box shows only valid CleanSweep backup files, in alphabetical order. Backup files 
have the extension BUP, BUD, BUS, BUU, BUB, or BUA.

Once you selected a folder/directory or drive, you choose the backup file you want to restore.

To select a backup file for restoration:

1 Select a file or type a filename in the File Name entry field. 

2 Click OK.

To restore the backup file:

 · Click Next (Alt+N).

CleanSweep determines which files are in the backup file and displays a list. You can
either choose to restore all the files, or you can remove files from the list to restore a 
portion of the program. 



Selecting Files
Backup files usually contain more than one file.    When you select a backup file, CleanSweep 
determines which individual files it contains and displays a list. You can either choose to restore 
all the files, or you can remove files from the list to restore a portion of the program. 

To restore all files:

· Click Next (Alt+N).

The list may contain files you do not want to restore.

To remove a file from the list so it will not be restored:

1 Click Only the files selected below (Alt+O).

2 Clear the check box of the file you want to remove by clicking it.

3 Click Next (Alt+N).



Taking Safety Precautions
After you have selected a backup file to restore, the Restore Wizard provides two optional safety 
precautions:    overwrite protection and confirmation of each file replacement. By default, the 
Wizard will replace older files only and confirm when it is about to overwrite a file.

To accept the default safety precautions:

· Click the Next button (Alt+N).

You can make permanent changes to these safety precautions to suit your preferences. See 
Changing Backup and Restore Options.

Related Topics:
File Replacements
File Replacement Confirmation



File Replacements
If any files being restored already exist in the destination folder/directory, you need to tell 
CleanSweep what action to take. By default, the Wizard will replace the files only if they are older 
than the files you are restoring. However, you have two other choices: you can replace all 
duplicate files, or you can never replace files, just add new ones.

To replace all duplicate files:

· Click the Replace all files option button (Alt+A).

To never replace files:

· Click the Never replace files, only add new files option button (Alt+R).



File Replacement Confirmation
By default, CleanSweep will confirm the replacement of any files. You may choose not to replace 
each file. 

To restore without confirming each file replacement:

· Click the No option button (Alt+O).



Selecting a Restore Location
After you select a backup file to restore, the Restore Wizard asks if you would like to restore the 
files to their previous location.

To restore the files to their original location:

· Click the Next button (Alt+N).

To change the location:

1 Click the No, let me select the location button (Alt+O).

2 Click the Next button (Alt+N).

3 Type the folder/directory or group to which you wish to restore the program.

4 Click the Next button (Alt+N).

CleanSweep displays a summary of what it is about to do.    The summary includes which files will
be restored and the number of bytes of disk space that will be freed.



Restoring
After you have selected a backup file to restore and selected a destination for the restored files, 
CleanSweep displays a summary of what it is about to do.    The summary includes which files will
be restored and the number of bytes of disk space that will be freed.    For more information on 
what will be restored, click the View button (Alt+V). 

When you have reviewed the summary information and are satisfied that it is correct, you are 
ready to restore.

To restore the program:

1 Click the Next button (Alt+N).

That's all there is to it.    The files are restored.    If you want to see more details about 
what CleanSweep did, you can view a summary, as described Viewing a Summary.

2 When you have finished viewing the summary, click the Finish button(Alt+F).

A dialog box asks if you want to delete the old backup file once the files have been 
restored. If you will not need the backup, it is a good idea to delete it to free up 
additional disk space. 

To delete the backup file:

· Click Yes (Alt+Y). 

To save the backup file:

· Click No (Alt+N). 



Viewing a Summary
When the restoration is complete, a dialog box reports the action as completed, and asks if you 
want to see a summary of what CleanSweep did.

To see a summary:

· Click the Summary button. 

An in-depth report appears.    The text window contains a detailed description of the 
actions performed, including the:

Date and time that the restoration was performed

Object that was restored

Restore location

Title of the folder or program group, if applicable

Title of the program and the complete pathname for each program in the folder or 
group

Whether any files were replaced 

Whether all or just some of the files were restored

Description of the program 

Number of bytes restored.

Note:  The number of bytes restored might be slightly larger than the approximate estimate (listed
just before you click the Finish button) due to "slack space." Each file is stored in clusters of a 
certain size, depending on the hard disk's partition size. The last cluster of a file takes a full 
cluster, whether it uses the space or not. For example, if your hard disk partition contained 4096-
byte clusters, restoring a 4097-byte file would restore 8192 bytes of disk space. For more 
information, see Viewing the Savings Report.

To print the report:

· Click the Print button (Alt+P).

The report prints.

To save the report in a file:

1 Click the Save button (Alt+S).

The Save Summary dialog box appears.

2 Type a filename for the report and then click Close (Alt+C). (If you are using 
Windows 3.1, 3.11, or NT, click OK.)



To close the report:

· Click the Close button (Alt+C).

The report closes.

MORE INFO:  The summary report describes one activity at a time.    For a report on all 
CleanSweep activity, take a look at the Master Log report, as described in Viewing the Master 
Log.

2 When you have finished viewing the summary, click the Finish button (Alt+F).

Related Topics:
Deleting a Backup File



Deleting a Backup File

If you no longer need a backup file, it is a good idea to delete it to free up additional disk space.

To delete a backup file:

1 Click the Restore Wizard icon in the CleanSweep Restore tab.

2 Select a backup file, as described in Selecting From the Default Backup 
Folder/Directory.

3 Click the Delete button.

A dialog box asks if you are sure you want to delete the backup file.

4 Click Yes.



Overview
In this topic you will learn how to view and print:

· The Master Log report of all CleanSweep activity.

· The Savings report, which gives a general overview of the disk space CleanSweep has 
freed.

· The Folder Usage report, which shows how much disk space each folder or file uses on your
hard drive.

The View tab on the main window offers options for three reports that summarize all CleanSweep 
activity, including how much disk space was saved as a result of using CleanSweep. 



Viewing the Master Log
The Master Log report displays all CleanSweep activity in chronological order.    (If you have not 
yet utilized any of CleanSweep's powerful features, there will not be any information in the master
log.)

To view the Master Log report:

1 Click the View tab in CleanSweep's main window.

2 Click the View Master Log icon (Alt+M) in CleanSweep's main window.

The Master Log report is a file composed of all of your previous summary reports. For
more information on what the summary reports contain, see "Viewing Summary 
Information" in the appropriate topic.

After you view the master log, you might want to save it to another file, or clear it, so the next time
you look at it you will see all new activity.

To save and clear the master log:

1 Click the Save button (Alt+S).

A dialog displays the CleanSweep folder, with the name SAVEREP.TXT in the File 
name text box. You may choose to save the Master Log to a different file name or 
folder. When you are finished, click the Save button (Alt+S) and then click OK.

2 Click the Clear button (Alt+L).

A dialog box asks if you are sure you want to clear the Master Log.

3 Click Yes to clear the log (Alt+Y).

CleanSweep clears the Master Log and will begin a new version of it.



Viewing the Savings Report
The Savings report displays the amount of disk space freed by the Wizards and the File Finders, 
the disk space used by backups, and the net disk space savings. When you delete a program or 
file and back it up, CleanSweep will calculate the space saved as the amount of space taken by 
the uninstalled components, minus the size of the backup, and will add this to the Savings log.    

To view the Savings log report:

1 Click the View tab in CleanSweep's main window.

The View buttons appear.

2 Click the View Savings icon (Alt+S).

The Savings report appears. All totals are in kilobytes (KB).

All totals are in kilobytes (KB). The first portion of the report shows the disk space freed by the 
Wizards and the Finders, then the total disk space freed.

The second portion of the report shows the disk space used by CleanSweep backup and archive 
files, and the total amount of disk space used by these files.

The last section of the report displays your total overall savings.The number is derived from the 
total disk space freed minus the total amount of disk space needed to store archive and backup 
files.

Note:  When you delete the backup, CleanSweep will not add this figure to the savings log.    
Similarly, if you choose to restore the component, CleanSweep will not subtract the original 
savings from the savings log.

If you delete a file from a source drive and back it up to a different target drive, the log will reflect 
the savings on the source, and will not account for size of the backup on the target.    (In many 
cases, the target will be a floppy drive.)

You may want to clear the savings report after you view it so it will show only new entries.

To clear the Savings report:

1 Click the Clear button (Alt+E).

A dialog box asks if you are sure you want to clear the Savings log.

2 Click Yes (Alt+Y) to clear the log.

CleanSweep resets the values displayed to zero, except for the "Space Used by" 
section, if backup and archive files still exist.    CleanSweep will begin a fresh log of 
disk space savings.

3 Click Close (Alt+O) to close the report.



Viewing the Folder/Directory Usage Report
The View Folder Usage report shows how much disk space each folder, directory, or file uses on 
your hard drive.    Use this report to analyze the total space used, free space remaining, and the 
difference between space allocated and actual space used (slack space) for each folder, 
directory, or file.

Files allocated under DOS may contain excess slack space.    DOS allocates a minimum amount 
of disk space for a file regardless of its actual size.    This minimum unit of space on the disk is 
known as a cluster, and if a file grows in size the additional space is allocated in units of at least 
one cluster.

For example, if you write a 2K file to a disk with a 4K cluster size, 2K of space (half the alloted 
space) will be wasted, or slack space. The View Folder Usage report helps you identify files that 
can be deleted or reallocated to make use of this wasted space. You may be able to reclaim a 
great deal of hard disk space by deleting a large number of files, even if the files themselves are 
relatively small.

NOTE:    If you are running Stacker 4.0 on your computer, please note that it contains technology 
that dramatically reduces the amount of slack space on your hard drive.    CleanSweep's 
calculations may not take Stacker's savings into account.

To view the Folder Usage report:

1 Click the View tab in CleanSweep's main window.

The View buttons appear.

2 Click the View Folder Usage icon (Alt+F).

The View Folder Usage report appears.

The report provides the following information for each hard drive:

Total size  The total space on the drive.

Used space The space currently used.
Free space The difference between the total space 

and the space currently used
Percent used The space used as a percentage of the 

total space on the drive.

For more in-depth folder/directory information, click the Folders button (Alt+F).

Related Topics:
Folder Information
File Information



Folder Information

To view the folder information report, double-click the drive name or click the Folders button 
(Alt+F) in the View Folder Usage window.    You can also choose Print (Alt+P) or Save (Alt+S) to 
print a copy of the report or save it to a file.

The Folder Information report provides the following information for each folder:

File count Number of files in the folder.

Actual size Actual space used by the files in the 
folder

Allocated size Total space allocated for the files in the 
folder

Percent used The percentage of files in the folder that 
have actually been used.

File Information

To view the file information report for all files in a particular folder, double-click the folder or click 
the Files button (Alt+F) in the View Folder Usage window.    You can also choose Print (Alt+P) or 
Save (Alt+S) to print a copy of the report or save it to a file.

The File Information report provides the following information for each file:

File count The number of files contained in the 
folder.

Actual size Actual space used by the file.
Allocated size Total space allocated for the file.
Percent used The difference between the allocated 

size and the actual size for the file (slack 
space).

Overview
In this topic you will learn how to:

· Control the Usage Monitor, including how and when the monitor will alert you to 
unused or infrequently used files.

· Control the Install Monitor, including what the monitor will recognize as an installation 
program and how to view installation log reports.

· Control safety precautions in the Backup and Restore Wizards and whether you want
to be alerted if you have old backup files on your computer.

· Change the default report filename.

You can use the Configure CleanSweep option on the Options tab to change the way 



CleanSweep operates to suit your preferences.

The basic steps for customizing CleanSweep are:

1 Choose the Options tab from the CleanSweep main window.

2 Click the Configure CleanSweep icon (Alt+C).

3 Choose the Usage Monitor, Install Monitor, Backup/Restore, or View tab.

4 Confirm or change the desired options.



Configuring the Usage Monitor (Windows 3.1x and
95 only)
CleanSweep's Usage Monitor runs in the background and makes a note each time you use a file 
on your computer. The Unused and Low Usage File Finders use this information to determine 
which files may no longer be needed.

The Usage Monitor is active by default; it starts automatically as part of the Windows startup 
process and remains active as long as Windows is running. The monitor uses approximately 1K 
of RAM, and its companion file CSHOOK.VXD uses about 8K of RAM.    

In Windows 95, an icon appears at the bottom of your desktop to indicate that the monitor is 
running. In Windows 3.1x, the Usage Monitor appears on the task list when the monitor is running
and a minimized icon appears on the desktop.

To configure the Usage Monitor, first select the Usage Monitor tab.    

To select the Usage Monitor tab:

1 Click the Options tab.

The Options screen appears.

2 Click the Configure CleanSweep icon (Alt+C).

The Usage Monitor tab appears.

The following sections tell you how to confirm or change the Usage Monitor options.

Related Topics:
Turning the Usage Monitor Off
Setting Usage Monitor Alert Options



Turning the Usage Monitor Off

The Usage Monitor must be running to track and report accurate information on how often files 
are used. You can turn the Usage Monitor off if you do not want to track file usage or if you want 
to save memory.

Windows automatically loads the Usage Monitor when it starts, whether or not you start 
CleanSweep.    You can prevent the Usage Monitor from loading when Windows starts.

To turn the usage monitor off:

1 Click Turn Usage Monitor off (Alt+F). To prevent the Usage Monitor from loading at 
startup, click the Load Usage Monitor at Startup check box to clear it.

2 Click Apply (Alt+A) to turn the Usage Monitor off without exiting the Usage Monitor 
tab.

Or

Click OK to turn the Usage Monitor off and exit the Usage Monitor tab.

In Windows 95, the Usage Monitor shuts down and the taskbar icon disappears from 
the desktop.    In Windows 3.1x, the Usage Monitor disappears from the task list and 
the minimized icon disappears from the desktop.



Setting Usage Monitor Alert Options

Use the Alert dialog box to control:

· The number of days a file may remain unused before the Usage Monitor alerts you.

· How often the Usage Monitor checks for unused files.

· What sound the Usage Monitor will use to alert you of unused files.

To set any of the Usage Monitor alert options:

1 Click the Alert button (Alt+E).

The Alert dialog box appears.

2 To define how often you will be alerted, click the box next to Alert if any file is 
unused for more than XX days. The default is 30 days. To change the number of 
days, type a new number over the old.

3 To check for unused files every time the Usage Monitor starts, click Each time usage
monitor starts.

Or

Click Every 30 days to check for unused files at a every 30 days. To change the 
number of days, type a new number over the old.

4 To define the alert sound, click the If unused files are found, alert with the sound: 
checkbox.    Type a sound filename, for example BELL.WAV, or click the ... button (the
Browse button) to search for another file.

5 Click OK.

Windows 95:  The File Usage Monitor in the lower right corner of the desktop will also flash if you
have checked the Alert if any file is unused for more than xx days option.



Configuring the Install Monitor (Windows 3.1x and
95 only)
The Install Monitor runs in the background to keep track of all files added and any changes made 
to existing configuration files when you install a program on your computer. CleanSweep uses 
this information later if you want to uninstall a program and its related files to ensure safe and 
thorough uninstallations. The Install Monitor is also very helpful to CleanSweep's move function.   
In particular, CleanSweep requires the assistance of the Install Monitor to modify correctly the 
location of files listed in the Windows 95 Registry.    

The Install Monitor is active by default; it starts automatically    as part of the Windows startup 
process and remains active as long as Windows is running.    The monitor uses approximately 1K 
of RAM, and its companion file CSHOOK.VXD uses about 8K of RAM.    

In Windows 95, an icon appears at the bottom of your desktop to indicate that the monitor is 
running. In Windows 3.1 and 3.11, the Install Monitor appears on the Windows task list when it is 
active and a minimized icon appears on the desktop.    

To configure the Install Monitor, first select the Install Monitor tab.

To select the Install Monitor tab:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Install Monitor tab.

The following Help topics tell you how to confirm or change the Install Monitor options.

Related Topics:
Turning the Install Monitor Off
Adding or Deleting Install Program Names
Tracking a Program Installation
Viewing or Deleting Install Monitor Logs



Turning the Install Monitor Off

The Install Monitor must be running to track and report accurate information about any files that 
are installed on your computer. You can turn it off if you do not want to track install information or 
to save memory. You can also prevent it from loading when Windows starts.

To turn the Install Monitor off:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Install Monitor tab.

4 Click Turn Install Monitor off (Alt+F). To prevent the monitor from loading when 
Windows starts, click the Load Install Monitor at Startup check box to clear it.

5 Click Apply (Alt+A) to turn the Install Monitor off without exiting the Install Monitor 
tab.

Or

Click OK to turn the Install Monitor off and exit the Install Monitor tab.

In Windows 95, the Install Monitor shuts down and the taskbar icon disappears. In 
Windows 3.1 and 3.11, the Install Monitor task disappears from the task list and the 
minimized icon disappers from the desktop.



Adding or Deleting Install Program Names

The Install Monitor recognizes that you are installing a program when you type any of the 
program names listed in the Program Names list box. For example, when you installed 
CleanSweep, you typed A:\SETUP.    CleanSweep recognizes the SETUP command as initiating 
an installation program and begins monitoring the process. You can add or delete names of install
programs.

To add install program names:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Install Monitor tab.

5 Click the Names button (Alt+N).

The Install Program Names dialog box appears.

6 Click Add (Alt+A).

The Add Install Name dialog box appears.

7 Enter the install program name.    

8 Click OK to add the install program name.

To delete install program names:

1 Click the Names button (Alt+N).

The Install Program Names dialog box appears.

2 Select the install program name to delete.

3 Click Delete (Alt+D).

A dialog box asks if you want to delete the install program name.

4 Click OK.



Tracking a Program Installation
When the Install Monitor is running in the background and you begin installing a new application 
on your computer, the Install Monitor "wakes up" and asks if you would like to monitor the 
installation. We suggest that you track the installation to ensure a safe, thorough uninstallation if 
the need ever arises.

To track a program installation:

1 Start installing a new application.

A dialog box asks if you would like to monitor the installation.

2 Click Yes (Alt+Y).

The Install Monitor tracks the program's installation, including any changes to existing
configuration files, and adds this information to the "Programs Monitored by Uninstall"
folder/program group which is included in folder/program group tree in each Wizard. 

NOTE:  Some setup programs are used both to install and to uninstall. If you are uninstalling a 
program, you should refrain from monitoring it by clicking No.

When the installation is complete, a dialog box asks you to enter a description for the 
just completed installation. This description will appear in the "Programs Monitored by
Install Monitor" folder/program group. 

2 You may type a new description or click OK to accept the suggested name. 

You might want to link and log this installation to a previously installed program. For 
example, you might install a database program and later install a program to produce
specialized reports from that database. To add this installation to a previous 
installation log, click Append (Alt+A). 

Note:  CleanSweep's Install Monitor may have difficulty logging the installation of the Microsoft 
Plus Pack and other system-level software that reboots the computer before the installation 
process is complete. If a newly installed program suggests that you restart Windows right away, 
please select the restart Windows later or equivalent option. By restarting Windows later, the 
Install Monitor can save the new installation information in a file with the extension .CIF. This file 
will not be saved if you restart Windows during the installation process.

A dialog informs you the record of the installation is complete.

3 Click OK.



Viewing or Deleting Install Monitor Logs

Use the Install Monitor Logs dialog box to view a summary of Install Monitor activity or delete 
Install Monitor logs. You view or delete a log.

To view Install Monitor logs:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Install Monitor tab.

4 Click the Logs button (Alt+L).

The Install Monitor Logs dialog box appears.

5 Select an existing log to view.    

6 Click Summary (Alt+S).

The Summary of Install Monitor Log dialog box appears.

7 Click Print (Alt+P) to print the log, Save (Alt+S) to specify a file for saving a copy of 
the log, or Close (Alt+O) to finish viewing the log summary.



Changing Backup and Restore Options
Use the Backup and Restore options to control where backup files are stored, what you want the 
Restore Wizard to do when it finds files with the same name, and whether you want to be alerted 
if a backup file is older than a certain number of days.

To change the Backup/Restore options, first select the Backup/Restore tab.

To select the Backup/Restore tab:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Backup/Restore tab.

The following sections explain how to confirm or change the options on the Backup/Restore tab.

Related Topics:
Changing the Default Backup Folder
Turning Off Uninstall Wizard File Confirmation
Turning Off Restore Wizard Options
Receiving a Reminder to Remove Old Backup Files



Changing the Default Backup Folder

Windows 95 and NT uses the default backup folder
C:\PROGRAM FILES\CLEANSWEEP\BACKUP 

Windows 3.1 and 3.11 uses the default backup folder 
C:\CLNSWEEP\BACKUP      

To enter a new default backup folder:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Backup/Restore tab.

4 Enter the new folder name in the Default Backup Folder box.

5 Click Apply (Alt+A) to change the default backup folder without closing the 
Backup/Restore tab.

Or

Click OK to change the default backup folder and exit the Backup/Restore tab.

If you want to search for an existing folder or directory to use as the default backup destination, 
follow this procedure.

To search for a default backup destination:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Backup/Restore tab.

4 Click the ... button (theBrowse button) beside the default destination name.

The Browse for Default Backup Directory dialog box appears.

5 Select the default backup destination.

6 Click Apply (Alt+A) to change the default backup folder without closing the 
Backup/Restore tab.

Or

Click OK to change the default backup destination and exit the Backup/Restore tab.



Turning Off Uninstall Wizard File Confirmation

The Uninstall Wizard gives you the option of confirming each file before it is removed.    This is 
usually unnecessary, and is not recommended.

To turn the confirmation option off:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Backup/Restore tab.

4 Clear the box: In uninstall Wizard, ask if confirmation is wanted.

The checkmark disappears.

5 Click Apply (Alt+A) to turn the confirmation option off without closing the 
Backup/Restore tab.

Or

Click OK to turn the confirmation option off and exit the Backup/Restore tab.



Turning Off Restore Wizard Options

The Restore Wizard gives you the following options when restoring files that already exist:

· Replace older files only

· Replace all files

· Never replace files, only add files.

Restore also gives you the option of confirming each file before it is replaced.    If you do not want 
to be prompted for these options, you can turn them off.

To turn the restore options off:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Backup/Restore tab.

4 Click the box In Restore Wizard, ask what action to take if file already exists.

The checkmark disappears.

5 Click Apply (Alt+A) to turn the restore options off without closing the Backup/Restore 
tab.

Or

Click OK to turn the restore options off and exit the Backup/Restore tab.



Receiving a Reminder to Remove Old Backup Files

CleanSweep can remind you when a backup file is older than a specified number of days.    The 
default is 90 days.

To turn the backup reminder option off:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the Backup/Restore tab.

4 Clear the box: Remind me if any backups created while uninstalling are older 
than 90 days.

The checkmark disappears.

5 Click Apply (Alt+A) to turn the backup reminder option off without closing the 
Backup/Restore tab.

Or

Click OK to turn the backup reminder option off and exit the Backup/Restore tab.

To change the backup reminder time:

1 Type a new number over the old in: Remind me if any backups created while 
uninstalling are older than 90 days.

2 Click Apply to change the backup reminder time without closing the Backup/Restore 
tab

Or

Click OK to change the backup reminder time and exit the Backup/Restore tab.



Changing the Default Report File
Windows 95 and NT use
 C:\PROGRAM FILES\CLEANSWEEP\SAVEREP.TXT 

and 

Windows 3.1 and 3.11 use
C:\CLNSWEEP\SAVEREP.TXT 

as the default report filename when you save a summary report. 

To change the default report filename, first select the View tab.

To select the View tab:

1 Click the Options tab.

2 Click the Configure CleanSweep icon (Alt+C).

3 Click the View tab.

To rename the default report filename:

1 Type the new filename in the Default Report File box.

2 Click Apply (Alt+A) to change the default report file without closing the View tab.

Or

Click OK to change the default report file and exit the View tab.

To store summary reports in an existing file:

1 Click the ... button (the Browse button) beside the default report file.

The Browse for Default Report File dialog appears.

2 Select the default report file and click Open (Alt+O).

3 Click Apply (Alt+A) to accept the default report file without closing the View tab.

Or

Click OK to accept the default report file and exit the View tab.






